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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 
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the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Overview 
The High-performance Embedded Workshop is a Graphical User Interface intended to ease the 
development and debugging of applications written in C/C++ programming language and assembly 
language for Renesas microcomputers. Its aim is to provide a powerful yet intuitive way of 
accessing, observing and modifying the debugging platform in which the application is running. 
 
This help explains the function as a "debugger" of High-performance Embedded Workshop. 
 

Target System 
The Debugger operates on the compact emulator system. 
 

Supported CPU 
This help explains the debugging function corresponding to the following CPUs. 
M16C/Tiny, R8C/Tiny Series 
 

Note: 
In this help, the information which depends on this CPU is described as "for M16C/R8C". 
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1. Features 

This debugger has the following functions. 
 

1.1 Real-Time RAM Monitor Function 
This function allows you to inspect changes of memory contents without impairing the realtime 
capability of target program execution. 
The compact emulator system has 1 Kbytes of RAM monitor area which can be located in any 
contiguous address location or in 4 separate blocks comprised of 256 bytes each. 
 

1.2 Break Functions 
Software Break 
This function causes the target program to stop immediately before executing the instruction at a 
specified address. 
Up to 64 breakpoints can be set. If multiple breakpoints are set, the program breaks at one of the 
breakpoints that is reached. 
 
Hardware Break 
This function causes the target program to stop upon detecting a data read/write to memory, 
instruction execution, or the rising/falling edge of the input signal fed from an external trace cable. 
The contents of events that can be set vary with each target MCU. Specified hardware break events 
can be used in one of the following combinations: 

 Break when all specified break points are effected.(And) 
 Break when all specified break points are effected simultaneously.(And(Same Time)) 
 Break when any one of the specified break points is effected.(Or) 

 
Address Interrupt Break 
This function stops the target program immediately before executing an instruction at a specified 
address. 
This function is realized by using the MCU's address interrupt interrupt. When debugging the 
MCU's address interrupt interrupt function, deselect the Enable the Address Match Interrupt 
Break Function check box on the MCU tab of the Init dialog box. That way, the address interrupt 
break function is disabled. 
 

1.3 Real-Time Trace Function 
This function records a target program execution history. 
Up to 64K cycles of execution history can be recorded. This record allows inspecting the bus 
information, executed instructions, and source program execution path for each cycle. 



 

 

1.4 GUI Input/Output Function 
This function simulates the user target system's key input panel (buttons) and output panel on a 
window. 
Buttons can be used for the input panel, and labels (strings) and LEDs can be used for the output 
panel. 
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1.5 About RAM Monitor Function 
This debugger supports the real time RAM monitor function which allows you to reference the 
memory data without sacrificing real time performance during execution of the target program. 
 

1.5.1 RAM Monitor Area 
This debugger has 1 Kbytes of RAM monitor area which can be located in any contiguous address 
location or in 4 separate blocks comprised of 256 bytes each. 
 

 
 

1.5.2 Sampling Period 
Sampling cycle means the display update interval. 
You can specify this function in any window which supports the RAM monitor. (The interval of 100 
ms is set by default.) 
The actual sampling cycle may take longer time than the specified cycle depending on the operating 
environment. (Sampling cycle depends on the following environments.) 

 Communication interface 
 Number of the RAM Monitor windows displayed 
 Size of the RAM Monitor window displayed 
 Number of ASM watch points within the RAM monitor area of the ASM Watch window 
 Number of C watch points within the RAM monitor area of the C Watch window 



 

 

1.5.3 Related Windows 
The window where the function of the real time RAM monitor function can be used is shown below. 
 

 RAM Monitor Window 
 ASM Watch Window 
 C Watch Window 
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1.6 About Software Breaks Function 
Software Break breaks the target program before execution of the command at the specified 
address. This break point is called software breakpoint. 
The software breakpoint is set/reset in the Editor (Source) window or in the S/W Breakpoint 
Setting window. You can also disable/enable a software breakpoint temporarily. 
You can specify up to 64 software breakpoints. When specifying two or more software breakpoints, 
the breakpoint combination is based on the OR logic. (Arrival to any one of breakpoints breaks the 
target program.) 
 

1.6.1 Setting of software breakpoint 
The software breakpoint can be set by the following windows. 

 Editor (Source) Window 
 S/W Break Point Setting Window 

You can double-click the mouse to set/reset the software breakpoint in the Editor (Source) window. 
You can also switch to temporarily disable/enable the software breakpoint in the S/W Breakpoint 
Setting window. 
 

1.6.2 Area where software breakpoint can be set 
The area which can be set for software breakpoint varies depending on the product. 
For the areas available for software breakpoint, see the following: 
 
The Internal RAM area and Internal ROM area can be designated for software breakpoint. 
 

ATTENTION 
During target program execution, a software break cannot be set as an internal ROM area. 
 



 

1.7 About Hardware Breaks Function 
The following designations are available as break events: 

 Address designation 
 Instruction fetch 
 Memory access 
 Bit access 

 External trigger designation 
 Interruption 

 
The number of events that can be specified are two events of all. For the address designation 
method, instruction fetch and memory access allow the range designation and logical condition 
designation, in addition to the normal one-address designation. Moreover, instruction fetch allows 
you to specify the function name. 
Memory access allows you to specify the comparison data to read/write data related to the specified 
address in the same manner as when setting the H/W breakpoint. It also allows mask designation 
to the comparison data. 
 
These break events can be combined as below: 

 Trace when all of the valid events are established (AND condition) 
 Trace when all of the valid events are established at the same time (simultaneous AND 

condition) 
 Trace when one of the valid events is established (OR condition) 
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1.8 About Address Interrupt Breaks Function 
This function stops the target program immediately before executing an instruction at a specified 
address. This function is realized by using the MCU's address match interrupt. 
The address interrupt break function can only be used when the address match interrupt is not 
used in the user application. The count of breakpoints depends on the connected MCU. 
 

Note 
The address interrupt break function can only be used when the Enable the Address Match 
Interrupt Break Function check box on the Init dialog box MCU tab is selected. 
 

1.8.1 Setting and Deleting a Break Points 
The address interrupt beakpoint can be set by the following windows. 

 Editor (Source) Window 
 Address Interrupt Break Point Setting Window 

You can double-click the mouse to set/reset the address interrupt breakpoint in the Editor (Source) 
window (same as software breakpoints). 
You can also switch to temporarily disable/enable the address interrupt breakpoint in the Address 
Interrupt Break Point Setting Window. 
 



 

1.9 About Real-time Trace Function 
The real-time trace function records the execution history of the target program. 
The execution history is referred to in the tracing window. 
The execution history can be referred to in the following mode. 

 BUS mode 
This mode allows you to inspect cycle-by-cycle bus information. The display content depends 
on the MCU and emulator system used. In addition to bus information, this mode allows 
disassemble, source line or data access information to be displayed in combination. 

 Disassemble mode 
This mode allows you to inspect the executed instructions. In addition to disassemble 
information, this mode allows source line or data access information to be displayed in 
combination. 

 Data access mode 
This mode allows you to inspect the data read/write cycles. In addition to data access 
information, this mode allows source line information to be displayed in combination. 

 Source mode 
This mode allows you to inspect the program execution path in the source program. 

 
 

1.9.1 Trace Area 
The 64K cycles execution history can be referred to with this debugger. 
The trace area of the following 5 mode is being supported. 

 Break 
64K cycles before target program stops 

 Before 
64K cycles before trace point 

 About 
32K cycles either side of trace point 

 After 
64K cycles after trace point 

 Full 
Until 64K cycles are written in the trace memory 

 

 
"Break" is set by default. To refer the execution history before stopping the target program, use 
"Break" (designation of trace event is not required). 
To refer the execution history at any position, or to continue execution of the target program, 
specify the trace event and change the trance range. 
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1.9.2 Trace Condition Setting 
The following designations are available as trace events: 

 Address designation 
 Instruction fetch 
 Memory access 
 Bit access 

 External trigger designation (eight events) 
 Interruption 

The number of events that can be specified are two events of all. These break events can be 
combined as below: 

 Trace when all of the valid events are established (AND condition) 
 Trace when all of the valid events are established at the same time (And(same time) 

comdition) 
 Trace when one of the valid events is established (OR condition) 

 
 

1.9.3 Trace Data Write Condition 
Trace data write conditions can be specified. 
You can specify the following write conditions: 

 Write conditions unlimited (default) 
 Cycles from the start event established to the end event established 
 Only cycles where the start event is established 
 Cycles from the start event established to the start event unestablished 
 Other than cycles from the start event established to the end event established 
 Other than cycles where the start event is established 
 Other than cycles from the start event established to the start event unestablished 

 



 

2. About the Compact Emulator 

The compact emulator is a small emulator equipped with the debugging function needed for 
full-scale development, such as real-time trace and a hardware break, though it is a handy price 
and a small body. 
 

2.1 Communication method 
The supported communication methods are as follows. 

Emulator I/F 
Compact Emulator 

USB Support 
 

2.2 Function table 
The supported functions are as follows. 
Function CPE 
SW Break 64 points 
HW Break 2 points 
Address Interrupt Break 4 points* 
Real-Time Trace 64K Cycles 
RAM Monitor 1K bytes (256bytes x 4blocks) area 
Time Measurement Go to Stop 
*Depends on the target MCU used. 
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3. Starting/Setup of Debugger 

Before starting the debugger, check the following contents: 

3.1 Communication method by emulator 
The supported communication methods are as follows. 

 The M30290T2-CPE is supporting USB as a communication interface. 
 

3.1.1 USB Interface 
 The supported host computer OS is Windows Me/98/2000/XP. USB communication cannot be 

used in any other OS. 
 Compliant with USB Standard 1.1. 
 Connections via USB hub are not supported. 
 By connecting the host computer and the emulator with USB cable, it is possible to install the 

supported device drivers using a wizard. 
 The necessary cable is included with the emulator. 

 



 

3.2 Download of Firmware 
It is necessary to down-load the firmware which corresponds to connected Compact Emulator when 
the debugger is started to the emulator. 
 

 You have setup the debugger for the first time. 
 You have upgraded emulator debugger. 

Press the system reset switch within two seconds after powering up the Compact Emulator to 
establish the maintenance mode. 
This debugger searches the version of the firmware downloaded to the emulator at start. Also when 
the firmware downloaded to the emulator is of old version, a mode which drives this debugger to 
download firmware is set. 
 
When this debugger gets started while the emulator is set in the mode which drives the debugger 
to download firmware forcedly, the following dialog is opened at start. 
Click the OK button to download the firmware. 
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3.3 Setting before emulator starts 

3.3.1 USB communication with the Emulator 
Connection of USB devices is detected by Windows' Plug & Play function. The device driver needed 
for the connected USB device is automatically installed. For details, see "3.4 Install of USB device 
driver ". 
 



 

3.4 Install of USB device driver 
The USB devices connected are detected by Windows' Plug & Play function. The installation wizard 
for USB device drivers starts after the device had been detected. The following shows the procedure 
for installing the USB device drivers. 
1. Connect the host computer and the emulator with USB cable. 
2. Set the emulator's communication interface switch to the "USB" position. Then turn on the 

power to the emulator. 
3. The dialog box shown below appears. 

 
Go on following the wizard, and a dialog box for specifying the setup information file (inf file) is 
displayed. Specify the musbdrv.inf file stored in a location below the directory where this debugger 
is installed. 
 

ATTENTION 
 Before the USB device drivers can be installed, the debugger you use must already be 

installed. Install this debugger first. 
 USB communication can be used only in Windows Me/98/2000/XP, and cannot be used in any 

other OSs. 
 When using Windows 2000/XP, a user who install the USB device driver need administrator 

rights. 
 During installation, a message may be output indicating that the device driver proper 

musbdrv.sys cannot be found. In this case, specify the musbdrv.sys which is stored in the 
same directory as is the musbdrv.inf file. 
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4. Preparation before Use 

4.1 Preparation before Use 
Please run the High-performance Embedded Workshop and connect the emulator. 
4.3 Starting the High-performance Embedded Workshop 
4.4 Starting the Debugger 
In addition, in order to debug with this product, it is necessary to create a workspace. 
 

4.2 Workspaces, Projects, and Files 
Just as a word processor allows you to create and modify documents, this product allows you to 
create and modify workspaces. 
 
A workspace can be thought of as a container of projects and, similarly, a project can be thought of 
as a container of project files. Thus, each workspace contains one or more projects and each project 
contains one or more files. 

 
 
Workspaces allow you to group related projects together. For example, you may have an application 
that needs to be built for different processors or you may be developing an application and library 
at the same time. Projects can also be linked hierarchically within a workspace, which means that 
when one project is built all of its "child" projects are built first. 
 
However, workspaces on their own are not very useful, we need to add a project to a workspace and 
then add files to that project before we can actually do anything. 
 



 

4.3 Starting the High-performance Embedded 
Workshop 

4.3.1 Method for Activating High-performance Embedded Workshop 
Activate the High-performance Embedded Workshop from [Programs] in the [Start] menu. 
The [Welcome!] dialog box is displayed. 

 
 
In this dialog box, A workspace is created or displayed. 

 [Create a new project workspace] radio button: 
Creates a new workspace. 

 [Open a recent project workspace] radio button: 
Uses an existing workspace and displays the history of the opened workspace. 

 [Browse to another project workspace] radio button: 
Uses an existing workspace; 
this radio button is used when the history of the opened workspace does not remain. 

 
In the case of Selecting an Existing Workspace, select [Open a recent project workspace] or [Browse 
to another project workspace] radio button and select the workspace file (.hws). 
 
 
Please refer to the following about the method to create a new workspace. 
4.3.2 Creating a New Workspace (Toolchain Used) 
4.3.3Creating a New Workspace (Toolchain Not Used) 
* When debugging the existing load module file with this product, a workspace is created by this 
method. 
 
The method to create a new workspace depends on whether a toolchain is or is not in use. Note that 
this product does not include a toolchain. Use of a toolchain is available in an environment where 
the C/C++ compiler package for the CPU which you are using has been installed. 
For details on this, refer to the manual attached to your C/C++ compiler package. 
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4.3.2 Creating a New Workspace (Toolchain Used) 

4.3.2.1 Step1 : Creation of a new workspace 

In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is 
activated, select the [Create a new project workspace] radio button and click the [OK] button. 
 
Creation of a new workspace is started. 
The following dialog box is displayed. 

 
 
1. Select the target CPU family 

In the [CPU family] combo box, select the target CPU family. 
2. Select the target toolchain 

In the [Tool chain] combo box, select the target toolchain name when using the toolchain. 
3. Select the project type 

In the [Project type] list box, select the project type to be used. 
In this case, select "Application" 
(Please refer to the manual attached to your C/C++ compiler package about the details of the 
project type which can be chosen.) 

4. Specify the workspace name and project name 
 In the [Workspace Name] edit box, enter the new workspace name. 
 In the [Project Name] edit box, enter the project name. When the project name is the same as 

the workspace name, it needs not be entered. 
 In the [Directory] edit box, enter the directory name in which the workspace will be created. 

Click the [Browse...] button to select a directory. 
 
After a setting, click the [OK] button. 
 



 

4.3.2.2 Step2 : Setting for the Toolchain 

A wizard for the project creation starts. 
 

 
 
Here, the following contents are set. 

 toolchain 
 the setting for the real-time OS (when using) 
 the setting for the startup file, heap area, stack area, and so on 

Please set required information and click the [Next] button. 
 
The contents of a setting change with C/C++ compiler packages of use. Please refer to the manual 
attached to your C/C++ compiler package about the details of the contents of a setting. 
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4.3.2.3 Step 3: Selecting of the Target Platform 

Select the target system used for your debugging (emulator, simulator). 
 
When the setting for the toolchain has been completed, the following dialog box is displayed. 

 
 
1. Selecting of the Target type 

In the [Target type] list box, select the target CPU type. 
 
2. Selecting of the Target Platform 

In the [Targets] area, the target for the session file used when this debugger is activated must 
be selected here. 
Check the box against the target platform. (And choose other target as required.) 

 
And click the [Next] button. 



 

4.3.2.4 Step4 : Setting the Configuration File Name 

Set the configuration file name for each of the all selected target. 
The configuration file saves the state of High-performance Embedded Workshop except for the 
target (emulator, simulator). 
 

 
 
The default name is already set. If it is not necessary to change, please click the [next] button as it 
is. 
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4.3.2.5 Step5 : The check of a created file name 

Finally, confirm the file name you create. The files which will be generated by the 
High-performance Embedded Workshop are displayed If you want to change the file name, select 
and click it then enter the new name. 

 
 
This is the end of the simulator settings. 
Exit the Project Generator following the instructions on the screen. 
 



 

4.3.3 Creating a New Workspace (Toolchain Not Used) 
When debugging the existing load module file with this product, a workspace is created by this 
method. 
 

4.3.3.1 Step1 : Creation of a new workspace 

In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is 
activated, select the [Create a new project workspace] radio button and click the [OK] button. 
 
Creation of a new workspace is started. The following dialog box is displayed. 

 
1. Select the target CPU family 

In the [CPU family] combo box, select the target CPU family. 
2. Select the target toolchain 

In the [Tool chain] combo box, select "None". In this case, toolchain is not used. 
(When the toolchain has not been installed, the fixed information is displayed in this combo 
box.) 

3. Select the project type 
(When the toolchain is not used, it is displayed on a [Project Type] list box as "Debugger only - 
Target Name". Select it. (When two or more project types are displayed, please select one of 
them.) 

4. Specify the workspace name and project name 
 In the [Workspace Name] edit box, enter the new workspace name. 
 In the [Project Name] edit box, enter the project name. When the project name is the same as 

the workspace name, it needs not be entered. 
 In the [Directory] edit box, enter the directory name in which the workspace will be created. 

Click the [Browse...] button to select a directory. 
 
After a setting, click the [OK] button. 
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4.3.3.2 Step 2: Selecting of the Target Platform 

Select the target system used for your debugging (emulator, simulator). 
 
A wizard starts and the following dialog box is displayed. 

 
 
1. Selecting of the Target type 

In the [Target type] list box, select the target CPU type. 
2. Selecting of the Target Platform 

In the [Targets] area, the target for the session file used when this debugger is activated must 
be selected here. 
Check the box against the target platform. (And choose other target as required.) 

 
And click the [Next] button. 
 



 

4.3.3.3 Step3 : Setting the Configuration File Name 

Set the configuration file name for each of the all selected target. 
The configuration file saves the state of High-performance Embedded Workshop except for the 
target (emulator, simulator). 

 
 
The default name is already set. If it is not necessary to change, please click the [next] button as it 
is. 
This is the end of the simulator settings. 
Exit the Project Generator following the instructions on the screen. 
 
And the dialog for the setup of a debugger is also displayed at this time (Details). If preparation of 
an simulator is completed, set up the debugger in this dialog box and connect with an simulator. 
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4.3.3.4 Step4 : Registering the Load modules to be downloaded 

Finally, register the load module file to be used. 
Select [Debug Settings...] from the [Debug] menu to open the [Debug Settings] dialog box. 

 
 
1. Select the product name to be connected in the [Target] drop-down list box. 
2. Select the format of the load module to be downloaded in the [Default Debug Format] 

drop-down list box. 
Format Name Contents 
IEEE695_RENESAS IEEE-695 format file (When Using NCxx) 
IEEE695_IAR IEEE-695 format file (When Using IAR cross tool) 
IEEE695_TASKING IEEE-695 format file (When Using Tasking cross tool) 
ELF/DWARF2_IAR ELF/DWARF2 format file (When Using IAR cross tool) 
ELF/DWARF2_TASKING ELF/DWARF2 format file (When Using Tasking cross tool) 
 
3. Then register the corresponding download module in the [Download Modules] list box. 

A download module can be specified in the dialog opened with a [Add...] button. 

 
 Enter the offset at which to load the download module in the [Offset] edit box. 
 Select the format of the download module in the [Format] edit box. Please refer to the upper 

table about the format name of a download module. 
 Enter the full path and filename of the download module in the [Filename] edit box. 
 Specifies the access size for the current download module in the [Access size] list box. 

 
After that, click the [OK] button. 



 

4.4 Starting the Debugger 
The debugging can be started by connecting with an emulator. 
 

4.4.1 Connecting the Emulator 
Connect the emulator by simply switching the session file to one in which the setting for the 
emulator use has been registered. 
 
The session file is created by default. The session file has information about the target selected 
when a project was created. 
In the circled list box in the following tool bars, select the session name including the character 
string of the target to connect. 

 
After the session name is selected, the dialog box for setting the debugger is displayed and the 
emulator will be connected. Details） 
 

4.4.2 Ending the Emulator 
The emulator can be exited by using the following methods: 
 
1. Selecting the "DefaultSession" 

Select the "DefaultSession" in the list box that was used at the time of emulator connection. 
2. Exiting the High-performance Embedded Workshop 

Select [Exit] from the [File] menu. High-performance Embedded Workshop will be ended. 
 
The message box, that asks whether to save a session, will be displayed when an emulator is exited. 
If necessary to save it, click the [Yes] button. If not necessary, click the [No] button. 
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5. Setup the Debugger 

The contents of an setup of a debugger differ depending on the product. 

5.1 Setup the Debugger for M16C/R8C 

5.1.1 Init Dialog 
In the Init dialog box, set up the contents listed below. The Init dialog box appears when the 
debugger starts up. Please click the tab name of the table about details.  
 
Tab Name Contents 
MCU Specify the setting the MCU file, Communication Interface, and so 

on. 
Debugging Information Specify the compiler used, storing of debugging information ahead. 
Emulator Specify the taget clock, the direction of input and output of the 

cable. 
Script Specify the operation when the debugger starts.  
 
To keep the Init dialog closed next time the debugger is started, check "Next Hide" at the bottom of 
the Init dialog. You can open the Init dialog using either one of the following methods: 

 After the debugger gets started, select Menu - [Setup]->[Emulator]->[System...]. 
 Start debugger while holding down the Ctrl key. 

 

5.2 MCU Setting Dialog 
Set the user target information in the MCU Setting dialog box. Close the Init dialog box before you 
open the MCU Setting dialog box. For details, click the tab name on the table you are interested in. 
Tab Name Contents 
MCU Specify the MCU's processor mode, debug options, etc. 
Flash Clear Specify whether to clear the contents of the MCU's internal flash ROM. 
If you do not want the MCU Setting dialog box to be displayed the next time you start the debugger, 
select the check box "Next Hide" at the bottom of the MCU Setting dialog box. You can open the 
MCU Setting dialog using either one of the following methods: After the debugger gets started, 
select Menu - [Setup]->[Emulator]->[Target...]. 



 

5.3 Init Dialog 
The Init dialog box is provided for setting the items that need to be set when the debugger starts up. 
The contents set from this dialog box are also effective the next time the debugger starts. The data 
set in this dialog remains effective for the next start. 

 
The tabs available on this dialog box vary with each product used. For details, click the desired tab 
name shown in the table below. 
 

Product Name Tab Name 
The debugger for M16C/R8C 

MCU exist 
Debugging Information exist 
Emulator exist 
Script exist 
 
To keep the Init dialog closed next time the debugger is started, check "Next Hide" at the bottom of 
the Init dialog. You can open the Init dialog using either one of the following methods: 

 After the debugger gets started, select Menu - [Setup] -> [Emulator] -> [System...]. 
 Start Debugger while holding down the Ctrl key. 
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5.3.1 MCU Tab 
The specified content becomes effective when the next being start. 

 
 

5.3.1.1 Specifying the MCU file 

 
Click the "Refer" button. 
The File Selection dialog is opened. Specify the corresponding MCU file. 
 

 An MCU file contains the information specific to the target MCU. 
 The specified MCU file is displayed in the MCU area of the MCU tab. 

 

5.3.1.2 Setting of the Communication Interface 

The displayed data varies depending on the specified communication interface. 
The available communication interface varies depending on the products. 
The following shows the setting for each communication interface. 

 5.3.2 Setting of the USB Interface 



 

 

5.3.1.3 Executing Self-Check 

Specify this option to execute self-check* on the emulator when the debugger starts up. 
 

 
 
Be sure to select the above check box only when you want to perform self-check at startup. Specify 
this option in the following cases: 

 When the firmware cannot be downloaded 
 When although the firmware is successfully downloaded, the debugger does not start 
 When the MCU goes wild or something is wrong with the trace results and you want to check 

whether the emulator is operating normally. 
Select the check box to close the Init dialog box. After connecting to the emulator and confirming 
the firmware, the debugger will immediately start self-check on the emulator. (Self-check takes 
about 30 seconds to 1 minute.) 
If an error is found in this self-check, the debugger displays the content of the error and is finished. 
When the self-check terminated normally, the dialog box shown below is displayed. When you click 
OK, the debugger starts up directly in that state. 
 

 
 
This specification is effective only when the debugger starts up. 
 
* Self-check refers to the function to check the emulator's internal circuit boards for memory 
condition, etc. Refer to the user's manual of your emulator for details about the self-check function. 
 

5.3.1.4 Using/unusing the address interrupt break function 

Specify whether or not to use the address interrupt break function. 
 

 
 To use the address interrupt break function (default) 

Select the check box shown above. 
In this case, the address interrupt break function is used by the emulator, and cannot be used 
in the user program. 

 Not to use the address interrupt break function 
Deselect the check box shown above. 
In this case, the address interrupt break function can be used in the user program. 

 
The contents set here are reflected at only startup time. 
 

5.3.1.5 Choosing to use or not to use CPU rewrite mode 

Specify whether or not you want to use CPU rewrite mode. (By default, CPU rewrite mode is 
unused.) 

 
Select the above check box when you are debugging the target system that uses CPU rewrite mode. 
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This specification can only be set or changed when you start the debugger. 
 

Supplementary explanation 
When debugging in CPU rewrite mode is enabled, the following limitations apply: 

 Address match breakpoints cannot be set. 
 No software breaks can be set in the internal ROM area. 
 The command Come cannot be executed in the internal ROM area. 

 
 

5.3.1.6 Choosing to use or not to use the trace point setting function 

Specify whether or not you want to use the trace point setting function. (By default, the trace point 
function is unused.) 

 
Select the above check box when you use the event of Compact emulator as a trace point. 
This specification can only be set or changed when you start Debugger. 
 

Supplementary explanation 
When the trace point setting function is enabled, the following limitations apply: 

 Hardware break function cannot use. 
 



 

5.3.2 Setting of the USB Interface 
USB communication uses the personal computer's USB interface. It is compliant with USB 1.1. 
 

5.3.2.1 Setting of the USB Interface 

Before USB communication can be performed, the computer must have a dedicated device driver 
installed in it. For details on how to install USB device drivers, see "Install of USB device driver." 
 
The currently USB-connected emulators are listed in the Serial No. area. Select the serial No. of 
the emulator you want to connect. 
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5.3.3 Debugging Information Tab 
The specified content becomes effective when the next being download. 

 
 

5.3.3.1 display the compiler used and its object format 

Display the compiler used and its object file format. 

 
Please specify the compiler used and its object file format in the dialog opened by menu [Debug] -> 
[Debug Settings...]. 
 

5.3.3.2 Specify the Storing of Debugging Information 

There are two methods for storing debugging information: on-memory and on-demand. 
Select one of these two methods. (The on-memory method is selected by default.) 
To select the on-demand method, click the On Demand check box. 

 On-memory method 
Debugging information is stored in the internal memory of your computer. 
This method is suitable when the load module (target program) size is small. 

 On-demand method 
Debugging information is stored in a reusable temporary file on the hard disk of your 
computer. 
Because the stored debugging information is reused, the next time you download the same 
load module it can be downloaded at high speed. 
This method is suitable when the load module (target program) size is large. 

 

Notes 
 If the load module size is large, the on-memory method may be inefficient because it requires a 

very large amount of time for downloading. In such a case, select the on-demand method. 
 In the on-demand method, a folder in which to store a reusable temporary file is created in the 

folder that contains the downloaded load module. This folder is named after the load module 
name by the word "~INDEX_" to it. If the load module name is "sample.abs", for example, the 
folder name is "~INDEX_sample". This folder is not deleted even after quitting the debugger. 

 



 

5.3.4 Emulator Tab 

 
 

5.3.4.1 Specify the Target Clock 

Change the setting by synchronizing with the clock used by the target microcomputer. (Internal is 
set by default.) 
 

 
Select Internal to set the internal clock, and External to set the external clock. 
The specified content becomes effective when the next being start. 
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5.3.5 Script Tab 
The specified content becomes effective when the next being start. 

 
 

5.3.5.1 Automatically Execute the Script Commands 

To automatically execute the script command at start of Debugger, click the "Refer" button to 
specify the script file to be executed. 
 

 
By clicking the "Refer" button, the File Selection dialog is opened. 
The specified script file is displayed in the "Init File:" field. 
To disable auto-execution of the script command, erase a character string displayed in the "Init 
File:" field. 
 



 

5.4 MCU Setting Dialog (the M16C/R8C Debugger) 
In the MCU Setting dialog box, setting information on the user target. The MCU Setting dialog box 
opens after closing the Init dialog box. 

 
The tabs available on this dialog box vary with each product used. For details, click the desired tab 
name shown in the table below.  
Tab Name Contents 
MCU Specify the MCU's processor mode, debug options, etc. 
Flash Clear Specify whether to clear the contents of the MCU's internal flash ROM. 
 
To keep the MCU Setting dialog box closed next time the debugger is started, check "Next Hide" at 
the bottom of the MCU Setting dialog box. You can open the MCU Setting dialog using either one of 
the following methods: 

 After the debugger gets started, select Menu - [Setup] -> [Emulator] -> [Target...]. 
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5.4.1 MCU Tab 
The specified content becomes effective when the next being start. 

 
 

5.4.1.1 Select the Processor Mode 

Specify the processor mode for the target system. 

 
Either the following can be specified. 

 Single-chip Mode 
Single-chip Mode 

Also, you need to specify the following information according to the processor mode you've selected. 
 PM10(b0 of 000005H) 

Specify whether you set the bit PM10 (b0 of 000005H). When you use your target system with 
the setting that PM10 is 1, check this option. 



 

 

5.4.1.2 Inspecting the MCU status 

Clicking this tab displays the status of each MCU pin. It allows to check whether the MCU pin 
status matches the processor mode to be set. 

 
"NC" means that the value is indeterminate. 
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5.4.2 Flash Clear Tab 
The specified content becomes effective when the next being start. 

 
 

5.4.2.1 Setting to clear the MCU's internal flash ROM 

Specify whether or not to clear the contents of the MCU's internal flash ROM when downloading 
the target program or data. The MCU's internal flash ROM is displayed block by block in the list 
view. 

 The blocks whose check marks are turned on do not have their flash contents cleared when 
downloading. The memory contents in places not overwritten by downloading remain intact. 

 The blocks whose check marks are turned off have their flash contents cleared when 
downloading. 

 Pressing the Select All button keeps all blocks from being cleared when downloading. 
Pressing the Clear All button clears all blocks when downloading. 
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6. Tutorial 

6.1 Introduction 
This section describes the main functions of the emulator by using a tutorial program. 
 
The tutorial program is based on the C program that sorts ten random data items in ascending or 
descending order. 
The tutorial program performs the following actions: 

 The tutorial function generates random data to be sorted. 
 The sort function sorts the generated random data in ascending order. 
 The change function then sorts the data in descending order. 

Note 
After recompilation, the addresses may differ from those given in this section. 
 
 

6.2 Usage 
Please follow these instructions: 

 Step1 : Starting the Debugger 
 Step2 : Checking the Operation of RAM 
 Step3 : Downloading the Tutorial Program 
 Step4 : Setting a Breakpoint 
 Step5 : Executing the Program 
 Step6 : Reviewing Breakpoints 
 Step7 : Viewing Register 
 Step8 : Viewing Memory 
 Step9 : Watching Variables 
 Step10 : Stepping Through a Program 
 Step11 : Forced Breaking of Program Executions 
 Step12 : Displaying Local Variables 
 Step13 : Stack Trace Function 

 



 

6.3 Step1 : Starting the Debugger 

6.3.1 Preparation before Use 
To run the High-performance Embedded Workshop and connect the emulator, refer to "エラー! 参照

元が見つかりません。 エラー! 参照元が見つかりません。". 
 

6.3.2 Setup the Debugger 
If it connects with an emulator, the dialog box for setting up a debugger will be displayed. Please 
set up the debugger in this dialog box. 
To setup the debugger in this dialog box, refer to "エラー! 参照元が見つかりません。 エラー! 参照元

が見つかりません。 ". 
After the setup of a debugger, it will function as a debugger. 
 

6.4 Step2 : Checking the Operation of RAM 
Check that RAM is operating correctly. Display and edit the contents of the memory in the 
[Memory] window to check that the memory is operating correctly. 

Note 
The memory can be installed on the board in some microcomputers. In this case, however, the 
above way of checking the operation of memory may be inadequate. It is recommended that a 
program for checking the memory be created. 
 

6.4.1 Checking the Operation of RAM 
Select [Memory] from the [CPU] submenu of the [View] menu and enter the RAM address (Here, 
enter H'400) in the [Display Address] edit boxes. The [Scroll Start Address] and [Scroll End 
Address] editing box is left to a default setting. (By default, the scroll range is set to 0h to the 
maximum address of MCU.) 

 
Note 
The settings of the RAM area differ depending on the product. For details, refer to the hardware 
manual. 
 
Click the [OK] button. The [Memory] window is displayed and shows the specified memory area. 
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Placing the mouse cursor on a point in the display of data in the [Memory] window and 
double-clicking allows the values at that point to be changed. 
 

6.5 Step3 : Downloading the Tutorial Program 

6.5.1 Downloading the Tutorial Program 
Download the object program to be debugged. 
 

 The Debugger for M16C/R8C 
Select [Download module] from [TutorialM16C.x30] under [Download modules]. 

 



 

 

6.5.2 Displaying the Source Program 
This debugger allows the user to debug a user program at the source level. 
 
Double-click [tutorial.c] under [C source file]. A [Editor(Source)] window opens and the contents of 
a "Tutorial.c" file are displayed. 

 
Select the [Format Views...] option from the [Setup] menu to set a font and size that are legible, if 
necessary. 
Initially the [Editor(Source)] window shows the start of the user program, but the user can use the 
scroll bar to scroll through the user program and look at the other statements. 
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6.6 Step4 : Setting a Breakpoint 
A software breakpoint is a basic debugging function. 
The [Editor(Source)] window provides a very simple way of setting a software breakpoint at any 
point in a program. 
 

6.6.1 Setting a Software Breakpoint 
For example, to set a software breakpoint at the sort function call: 
 
Double-click the [S/W breakpoints] column on the line containing the sort function call. 

 
The red symbol will appear on the line containing the sort function call. This shows that a 
softwarebreak breakpoint has been set. 
 
 
Next 
Step5 : Executing the Program 
 
 
 



 

6.7 Step5 : Executing the Program 
Execute the program as described in the following: 

6.7.1 Resetting of CPU 
By default, CPU is not reset after downloading a program. 

To reset the CPU, select [Reset CPU] from the [Debug] menu, or click the [Reset CPU] button  
on the toolbar. 
 

6.7.2 Executing the Program 

To execute the program, select [Go] from the [Debug] menu, or click the [Go] button  on the 
toolbar. 
 
The program will be executed up to the breakpoint that has been set, and an arrow will be 
displayed in the [S/W Breakpoints] column to show the position that the program has halted. 

 
 

Note 
When the source file is displayed after a break, a path of the source file may be inquired. In this 
case, please specify the location of a source file. 
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6.7.3 Reviewing Cause of the Break 
The break factor is displayed in the [Output] window. 

 
 
The user can also see the cause of the break that occurred last time in the [Status] window. 
Select [Status] from the [CPU] submenu of the [View] menu. After the [Status] window is displayed, 
open the [Platform] sheet, and check the Status of Cause of last break. 

 
Please refer to "エラー! 参照元が見つかりません。 エラー! 参照元が見つかりません。 " about the 
notation of a break factor. 
 



 

6.8 Step6 : Reviewing Breakpoints 
The user can see all the breakpoints set in the program in the [S/W Break Points] window. 

6.8.1 Reviewing Breakpoints 
Select [S/W Break Points] from the [Break] submenu of the [View] menu. The [S/W Break Points] 
window is displayed. 

 
This window allows the user to set or change breakpoints, define new breakpoints, and delete, 
enable, or disable breakpoints. 
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6.9 Step7 : Viewing Register 
The user can see all registers/flags value in the [Register] window. 
 

6.9.1 Viewing Register 
Select [Registers] from the [CPU] submenu of the [View] menu. The [Register] window is displayed. 

 

6.9.2 Setting the Register Value 
You can change a register/flag value from this window. 
Double-click the register line to be changed. The dialog is opened. Enter the value to be changed. 

 
 



 

6.10 Step8 : Viewing Memory 
When the label name is specified, the user can view the memory contents that the label has been 
registered in the [ASM Watch] window. 
 

6.10.1 Viewing Memory 
For example, to view the memory contents corresponding to __msize in word size: 
 
Select [ASM Watch] from the [Symbol] submenu of the [View] menu, open the [ASM Watch] 
window. 
And click the [ASM Watch] window with the right-hand mouse button and select [Add...] from the 
popup menu, enter __msize in the [Address] edit box, and set Word in the [Size] combo box. 

 
 
Click the [OK] button. The [ASM Watch] window showing the specified area of memory is 
displayed. 
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6.11 Step9 : Watching Variables 
As the user steps through a program, it is possible to watch that the values of variables used in the 
user program are changed. 

6.11.1 Watching Variables 
For example, set a watch on the long-type array a declared at the beginning of the program, by 
using the following procedure: 
 
Click the left of displayed array a in the [Editor(Source)] window to position the cursor, and select 
[Add C Watch...] with the right-hand mouse button. The [Watch] tab of [C watch] window in which 
the variable is displayed opens. 

 
 
The user can click mark '+' at the left side of array a in the [C Watch] window to watch all the 
elements. 

 



 

 

6.11.2 Registering Variable 
The user can also add a variable to the [C Watch] window by specifying its name. 
 
Click the [C Watch] window with the right-hand mouse button and select [Add...] from the popup 
menu. 
The following dialog box will be displayed. Enter variable i. 

 
 
Click the [OK] button. The [C Watch] window will now also show the int-type variable i. 
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6.12 Step10 : Stepping Through a Program 
This debugger provides a range of step menu commands that allow efficient program debugging. 
1. Step In 

Executes each statement, including statements within functions. 
2. Step Out 

Steps out of a function, and stops at the statement following the statement in the program 
that called the function. 

3. Step Over 
Executes a function call in a single step. 

4. Step... 
Steps the specified times repeatedly at a specified rate. 

 

6.12.1 Executing [Step In] Command 
The [Step In] command steps into the called function and stops at the first statement of the called 
function. 
 
To step through the sort function, select [Step In] from the [Debug] menu, or click the [Step In] 

button  on the toolbar. 
The PC cursor moves to the first statement of the sort function in the [Editor(Source)] window. 

 
 
 



 

6.12.2 Executing [Step Out] Command 
The [Step Out] command steps out of the called function and stops at the next statement of the 
calling statement in the main function. 
 
To step out of the sort function, select [Step Out] from the [Debug] menu, or click the [Step Out] 

button  on the toolbar. 
The PC cursor slips out of a sort function, and moves to the position before a change function. 

 
Note 
It takes time to execute this function. When the calling source is clarified, use [Go To Cursor]. 
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6.12.3 Executing [Step Over] Command 
The [Step Over] command executes a function call as a single step and stops at the next statement 
of the main program. 
 
To step through all statements in the change function at a single step, select [Step Over] from the 

[Debug] menu, or click the [Step Over] button  on the toolbar. 
The PC cursor moves to the next position of a change function. 

 
 
 



 

6.13 Step11 : Forced Breaking of Program Executions 
This debugger can force a break in the execution of a program. 
 

6.13.1 Forced Breaking of Program Executions 
Cancel all breaks. 
To execute the remaining sections of the main function, select [Go] from the [Debug] menu or the 

[Go] button  on the toolbar. 
 
The program goes into an endless loop. To force a break in execution, select [Halt Program] from 

the [Debug] menu or the [Halt] button  on the toolbar. 
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6.14 Step12 : Displaying Local Variables 
The user can display local variables in a function using the [C Watch] window. 
 

6.14.1 Displaying Local Variables 
For example, we will examine the local variables in the tutorial function, which declares four local 
variables: a, j, i, and sam. 
 
Select [C Watch] from the [Symbol] submenu of the [View] menu. The [C Watch] window is 
displayed. By default, [C watch] window has four tabs as following: 

 [Watch] tab 
Only the variable which the user registered is displayed. 

 [Local] tab 
All the local variables that can be referred to by the scope in which the the PC exists are 
displayed. If a scope is changed by program execution, the contents of the [Local] tab will also 
change. 

 [File Local] tab 
All the file local variables of the file scope in which the PC exists are displayed. If a file scope 
is changed by program execution, the contents of the [File Local] tab will also change. 

 [Global] tab 
All the global variables currently used by the downloaded program are displayed. 

Please choose the [Local] tab, when you display a local variable. 

 
 
Click mark '+' at the left side of array a in the [Locals] window to display the elements. 
When the user refers to the elements of array a before and after the execution of the sort function, 
it is clarified that random data is sorted in descending order. 
 



 

6.15 Step13 : Stack Trace Function 
The emulator uses the information on the stack to display the names of functions in the sequence of 
calls that led to the function to which the program counter is currently pointing. 

6.15.1 Reference the function call status 
Double-click the [S/W Breakpoints] column in the sort function and set a software breakpoint. 

 
 
To executes the user program from the reset vector address, select [Reset Go] from the [Debug] 

menu, or click the [Reset Go] button  on the toolbar. 
 
After the break in program execution, select [Stack Trace] from the [Code] submenu of the [View] 
menu to open the [Stack Trace] window. 

 
 
The upper figure shows that the position of the program counter is currently at the selected line of 
the sort() function, and that the sort() function is called from the tutorial() function. 
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6.16 What Next? 
This tutorial has described the usage of this debugger. 
 
Sophisticated debugging can be carried out by using the emulation functions that the emulator 
offers. This provides for effective investigation of hardware and software problems by accurately 
isolating and identifying the conditions under which such problems arise. 
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7. Windows 

The window of this debugger is shown below. 
 
Window Name View Menu 
RAM Monitor Window [View]->[CPU]->[RamMonitor]  
ASM Watch Window [View]->[Symbol]->[ASMWatch]  
C Watch Window [View]->[Symbol]->[CWatch]  
Script Window [View]->[Script]  
S/W Break Point Setting Window [View]->[Break]->[S/W Break Points]  
H/W Break Point Setting Window [View]->[Break]->[H/W Break Points]  
Address Interrupt Break Point Setting 
Window 

[View]->[Break]->[Address Interrupt Break Points]  

Trace Point Setting Window [View]->[Trace]->[Trace Points]  
Trace Window [View]->[Trace]->[Trace]  
GUI I/O Window [View]->[Graphic]->[GUI I/O]  
 
For the reference of the following windows, refer to the help attached to a High-performance 
Embedded Workshop main part. 

 Differences Window 
 Map Window 
 Command Line Window 
 Workspace Window 
 Output Window 
 Disassembly Window 
 Memory Window 
 IO Window 
 Status Window 
 Register Window 
 Image Window 
 Waveform Window 
 Stack Trace Window 

 



 

7.1 RAM Monitor Window 
The RAM monitor window is a window in which changes of memory contents are displayed while 
running the target program. 
The relevant memory contents are displayed in dump form in the RAM monitor area by using the 
realtime RAM monitor function. The displayed contents are updated at given intervals (by default, 
every 100 ms) while running the target program. 
 

 
 

 This system has 1 Kbyte of RAM monitor area which can be located in any contiguous address 
location or in 4 separate blocks comprised of 256 bytes each. 

 The RAM monitor area can be changed to any desired address range. 
Refer to "7.1.2 Setting the RAM monitor area " for details on how to change the RAM monitor 
area. 
The default RAM monitor area is mapped into a 1-Kbyte area beginning with the start address 
of the internal RAM. 

 The display content updating interval can be set for each window individually. 
The actual updating interval at which the display contents are actually updated while running 
the target program is shown in the title field of the Address display area. 

 The background colors of the data display and code display areas are predetermined by access 
attribute, as shown below. 

 
 
Access attribute Background color 
Read accessed address Green 
Write accessed address Red 
Non-accessed address White 
 
The background colors can be changed. 
 

ATTENTION 
 The RAM monitor window shows the data that have been accessed through the bus. Therefore, 

changes are not reflected in the displayed data unless they have been accessed via the target 
program as in the case where memory is rewritten directly from an external I/O. 

 If the data in the RAM monitor area are displayed in lengths other than the byte, it is possible 
that the data will have different memory access attributes in byte units. If bytes in one data 
have a different access attribute as in this case, those data are enclosed in parentheses when 
displayed in the window. In that case, the background color shows the access attribute of the 
first byte of the data. 
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 The displayed access attributes are initialized by downloading the target program. 
 The interval time at which intervals the display is updated may be longer than the specified 

interval depending on the operating condition (shown below). 
 Host machine performance/load condition 
 Communication interface 
 Window size (memory display range) or the number of windows displayed 

 



 

7.1.1 Extended Menus 
This window has the following popup menus that can be brought up by right-clicking in the 
window. 
 
Menu Function 
RAM Monitor Area... Set RAM monitor base address. 
Sampling Period... Set RAM monitor sampling period. 
Clear Clear access attribute. 
Up Moves display position to the immediately preceding RAM 

monitor area (smaller address) 
Down Moves display position to the immediately following RAM 

monitor area (larger address) 
Address... Display from specified address. 
Scroll Area... Specify scroll range. 

1byte Display in 1Byte unit. 
2bytes Display in 2Byte unit. 
4bytes Display in 4Byte unit. 

Data Length 

8bytes Display in 8Byte unit. 
Hex Display in Hexadecimal. 
Dec Display in Decimal. 
Single Dec Display in Signed Decimal. 
Oct Display in Octdecimal. 

Radix 

Bin Display in Binary. 
ASCII Display as ASCII character. 
SJIS Display as SJIS character. 
JIS Display as JIS character. 
UNICODE Display as UNICODE character. 
EUC Display as EUC character. 
Float Display as Floating-point. 

Code 

Double Display as Double Floating-point. 
Label Switch display or non-display of Label area. 
Register Switch display or non-display of Register area. 

Layout 

Code Switch display or non-display of Code area. 
Column... Set the number of columns displayed on one line. 
Split Split window. 
Toolbar display Display toolbar. 
Customize toolbar... Open toolbar customize dialog box. 
Allow Docking Allow window docking. 
Hide Hide window. 
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7.1.2 Setting the RAM monitor area 
Choose the popup menu [RAM Monitor Area...] in the RAM monitor window. 
 
The RAM monitor area setup window shown below will appear. The currently set RAM monitor 
areas are listed in this window. 
 

 
 
Use this window to add, delete or change RAM monitor areas. 

 Specify a RAM monitor area by its start address and size (the latter by a number of blocks.) 
 The start address can be specified in 0x100 byte units. 

If you specify a non-aligned address value, it is rounded off to the nearest address value in 
0x100 byte units before being set. 

 Specify the size of the RAM monitor area by a number of blocks. 
For the Compact Emulator, one block is 256 bytes in size. Up to 4 blocks can be specified. 

 RAM monitor areas can be added until the total number of blocks used reaches 4. 
(The number of blocks (and the size) that are currently available to use are displayed below 
the list.) 

 



 

7.1.3 Changing the RAM Monitor Area 
The start address and the size of the RAM monitor area can be changed. 

 Changing from a dialog box 
Select the RAM monitor area you want to change from a list of RAM monitor areas and 
double-click on it. 
The Set RRAM Area dialog box shown below will appear. Specify the start address and the 
size (by a number of blocks) of the RAM monitor area in the Start and the Size fields of this 
dialog box. 
 

 
 
 

 Changing directly in the window 
Select the RAM monitor area you want to change from a list of RAM monitor areas and click 
again in its Start display column or Size display column. 
Specify a new start address or a new size with which you want to be changed in the ensuing 
edit box. Press the Enter key to confirm what you've entered, or the Esc key to cancel. 
 

 
 

7.1.4 Adding RAM Monitor Areas 
Click the [Add...] button. 
The Set RRAM Area dialog box will appear. Specify the start address and the size (by a number of 
blocks) of a new RAM monitor area in the Start and the Size fields of this dialog box. 
 

7.1.5 Deleting RAM Monitor Areas 
Select the RAM monitor area you want to delete from a list of RAM monitor areas and click the 
[Remove] button. 
To delete all RAM monitor areas, click the [Remove All] button. 
 

 
72 



7 Windows 

 
73 

7.2 ASM Watch Window 
The ASM watch window is a window in which you can register specific addresses as watchpoints 
and inspect memory contents at those addresses. 
If a registered address resides within the RAM monitor area, the memory content at that address is 
updated at given intervals (by default, every 100 ms) during program execution. 
 

 
 

 The addresses to be registered are called the "watchpoints." One of the following can be 
registered: 

 Address (can be specified using a symbol) 
 Address + Bit number 
 Bit symbol 

 The registered watchpoints are saved in the debugger when the ASM watch window is closed 
and are automatically registered when the window is reopened. 

 If symbols or bit symbols are specified for the watchpoints, the watchpoint addresses are 
recalculated when downloading the target program. 

 The invalid watchpoints are marked by "-<not active>-" when displayed on the screen. 
 The order in which the watchpoints are listed can be changed by a drag-and-drop operation. 
 The watchpoint expressions, sizes, radixes and datas can be changed by in-place editing. 

 

ATTENTION 
 The RAM monitor obtains the data accessed through the bus. Any change other than the 

access from the target program will not be reflected. 
 If the display data length of the RAM monitor area is not 1 byte, the data's access attribute to 

the memory may varies in units of 1 byte. In such a case that the access attribute is not 
unified within a set of data, the data's access attribute cannot be displayed correctly. In this 
case, the background colors the access attribute color of the first byte of the data. 

 



 

 

7.2.1 Extended Menus 
This window has the following popup menus that can be brought up by right-clicking in the 
window. 
 
Menu Function 
Add... Add watchpoint. 
Add Bit... Add bit-lebel watchpoint. 
Remove Remove the selected watchpoint. 
Remove All Remove all watchpoints. 
Set... Set new data to selected watchpoint. 

Bin Display in Binary. 
Dec Display in Decimal. 

Radix 

Hex Display in Hexadecimal. 
Refresh  Refresh memory data. 

Address Area Switch display or non-display of Address area. Layout 
Size Area Switch display or non-display of Size area. 
Enable RAM Monitor Switch enable or disable RAM moniter function. RAM Monitor 
Sampling Period... Set RAM monitor sampling period. 

Toolbar display Display toolbar. 
Customize toolbar... Open toolbar customize dialog box. 
Allow Docking Allow window docking. 
Hide Hide window. 
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7.3 C Watch Window 
The C Watch Window displays C/C++ expressions and their values (results of calculations). 
The C/C++ expressions displayed in the C Watch Window are known as C watchpoints. The 
displays of the results of calculating the C watchpoints are updated each time a command is 
executed. 
When RAM monitor function is effective and the C watch points are within the RAM monitor area, 
the displayed values are updated during execution of the target program. 
 

 
 

 Variables can be inspected by scope (local, file local or global). 
 The display is automatically updated at the same time the PC value changes. 
 Variable values can be changed. 
 The display radix can be changed for each variable individually. 
 Any variable can be registered to the Watch tab, so that it will be displayed at all times: 

 The registered content is saved for each project separately. 
 If two or more of the C watch window are opened at the same time, the registered 

 The C watchpoints can be registered to separate destinations by adding Watch tabs. 
 Variables can be registered from another window or editor by a drag-and-drop operation. 
 The C watchpoints can be sorted by name or by address. 
 Values can be inspected in real time during program execution by using the RAM monitor 

function. 



 

 

ATTENTION 
 You cannot change the values of the C watch points listed below: 

 Bit field variables 
 Register variables 
 C watch point which does not indicate an address(invalid C watch point) 

 If a C/C++ language expression cannot be calculated correctly (for example, when a C/C++ 
symbol has not been defined), it is registered as invalid C watch point. 
It is displayed as "--<not active>--". If that C/C++ language expression can be calculated 
correctly at the second time, it becomes an effective C watch point. 

 The display settings of the Local, File Local and Global tabs are not saved. The contents of the 
Watch tab and those of newly added tabs are saved. 

 The RAM monitor obtains the data accessed through the bus. Any change other than the 
access from the target program will not be reflected. 

 The variables, which are changed in real-time, are global variables and file local variables 
only. 

 If the display data length of the RAM monitor area is not 1 byte, the data's access attribute to 
the memory may varies in units of 1 byte. In such a case that the access attribute is not 
unified within a set of data, the data's access attribute cannot be displayed correctly. In this 
case, the background colors the access attribute color of the first byte of the data. 

 

7.3.1 Extended Menus 
This window has the following popup menus that can be brought up by right-clicking in the 
window. 
 
Menu Function 
Add... Add C watchpoint. 
Remove Remove the selected C watchpoint. 
Initialize Reevaluates the selected C watchpoint. 
Set New Value... Set new data to selected C watchpoint. 

Hex Display in Hexadecimal. 
Bin Display in Binary. 
Default Display in Default Radix. 

Radix 

Toggle(All Variables) Change radix (toggle). 
Refresh  Refresh memory data. 
Hide type name  Hide type names from variables. 
Show char* as string  Selects whether to display char* type as a string. 

Sort by Name Sort variables by its name. Sort 
Sort by Address Sort variables by its address. 
Enable RAM Monitor Switch enable or disable RAM moniter function. RAM Monitor 
Sampling Period... Set RAM monitor sampling period. 

Add New Tab... Add new tab. 
Remove Tab Remove the selected tab. 
Toolbar display Display toolbar. 
Customize toolbar... Open toolbar customize dialog box. 
Allow Docking Allow window docking. 
Hide Hide window. 
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7.4 Script Window 
The Script Window displays the execution of text -format script commands and the results of that 
execution. 
Script commands can be executed using a script file or interactively. You can also write script 
commands in the script file so that they are automatically executed. The results of script command 
execution can also be stored in a previously specified log file. 
 

 
 

 The Script Window has a view buffer that stores the results of executing the last 1000 lines. 
The results of execution can therefore be stored in a file (view file) without specifying a log file. 

 When a script file is opened, the command history area changes to become the script file 
display area and displays the contents of the script file. When script files are nested, the 
contents of the last opened script file are displayed. The script file display area shows the line 
currently being executed in inverse vide. 

 When a script file is open, you can invoke script commands from the command input area 
provided the script file is not being executed. 

 The Script Window can record the history of the executed commands to a file. This function is 
not the same as the log function. This function records not the result but only the executed 
commands, so the saved files can be used as the script files. 

 



 

 

7.4.1 Extended Menus 
This window has the following popup menus that can be brought up by right-clicking in the 
window. 
 
Menu Function 

Open... Open script file. 
Run Run script file. 
Step One step execution of script file. 

Script 

Close Close script file. 
Save... Save view buffer to file. View 
Clear Clear view buffer. 
On... Open log file and start recording (start output to file). Log 
Off Close log file and end recording (stop output to file). 
On... Record the executed commands to a file. Record 
Off Stop recording the executed commands. 

Toolbar display Display toolbar. 
Customize toolbar... Open toolbar customize dialog box. 
Allow Docking Allow window docking. 
Hide Hide window. 
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7.5 S/W Break Point Setting Window 
The S/W Break Point Setting window allows you to set software break points. 
Software breaks stop the execution of instructions immediately before the specified break point. 
 

 
 If you have set multiple software breakpoints, program execution stops when any one software 

break address is encountered (OR conditions). 
 You can continue to set software breakpoints until you click the "Close" button to close the 

S/W Break Point Setting Window. 
 You can clear, enable or disable software breakpoints selected by clicking in the software 

breakpoint display area. You can also enable and disable software breakpoints by 
double-clicking on them. 

 Click on the "Save" button to save the software break points in the file. To reload software 
break point settings from the saved file, click the "Load" button. If you load software break 
points from a file, they are added to any existing break points. 

 



 

 

7.5.1 Command Button 
The buttons on this window has the following meanings.  
Button Function 
Load... Load setting information from a file in which it was saved. 
Save... Save the contents set in the window to a file. 
Help Display the help of this window. 
Add Add the break point. 
Refer... Open file selection dialog box. 
Close Close the window. 
Delete Remove the selected break point. 
Delete All Remove all break points. 
Enable Enable the selected break points. 
All Enable Enable all break points. 
Disable Disable the selected break point. 
All Disable Disable all break points. 
View Shows the selected breakpoint positions in the Editor(Source) window. 
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7.5.2 Setting and Deleting a Break Points from Editor(Source) Window 
The area which can be set in the software breakpoint is different according to the product. Please 
refer to "1.6.2 Area where software breakpoint can be set" for details. 
 

7.5.2.1 Setting and Deleting a Break Point from Editor(Source) Window 

You can set break points in the Editor(Source) Window. To do so, double-click the break point 
setting area ("S/W breakpoints" column) for the line in which you want to set the break. (A red 
marker is displayed on the line to which the break point was set.) 
 

 
 
You can delete the break point by double-clicking again in the break point setting area ("S/W 
breakpoints" column). 
 
In the Editor(Source) window, a display of "S/W breakpoints" column is set to "Enable" by default. 
To erase this column, deselect the [S/W breakpoints] check box in the dialog box opened by choosing 
the main menu - [Edit] -> [Define Column Format]. The "S/W breakpoints" column is erased from 
all Editor (Source) windows. And select popup menu - [Columns] -> [S/W breakpoints] in the Editor 
(Source) window, A column can be set up for each Editor (Source) windows. 
 



 

7.6 H/W Break Point Setting Window 
The H/W Breakpoint Setting window is used to set hardware breakpoints for the Emulators. 
 

 
 

 The events listed below can be specified as break events. If the contents of events are altered, 
they are marked by an asterisk (*) on the title bar. The asterisks (*) are not displayed after 
setting up the emulator. 
          Fetch, Memory Access, Bit Access 

 Events at up to two points can be used. 
The H/W Break Point Setting window and the Trace Point Setting windows use the same 
resource of the emulator. Use the MCU tab in the Init dialog box, in order to specify for which 
function the resources are used. On this tab, deselect the Enable the Trace Point Function 
check box.(Details) 

 These events can be combined in one of the following ways: 
 Break when all of the valid events are established (AND condition) 
 Break when all of the valid events are established at the same time (simultaneous AND 

condition) 
 Break when one of the valid events is established (OR condition) 

 At the time the debugger starts up, the hardware breaks have no effect. 
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7.6.1 Specify the Break Event 
To set events, double-click to select the event you want to set from the event setting area of the 
H/W Break Point Setting Window. This opens the dialog box shown below. 

 
 



 

Following events can be set by specifying Event Type in this dialog box. 
 When FETCH is selected 

Breaks for the instruction fetch. 

 
 

 When DATA ACCESS is selected 
Breaks for the memory access. 
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 When BIT SYMBOL is selected 

Breaks for the bit access. 

 
 



 

 

7.6.2 Specify the Combinatorial Condition 
To specify a combinatorial condition, specify the desired condition from the combinatorial condition 
specification area. 

 When AND or OR is selected 
In the event specification area, the event used and a pass count for that event can be specified. 
To alter the pass count, while the event to alter is being selected, click the pass count value of 
that event. 

 
 

 When AND (Same Time) is selected 
In the event specification area, the event used can be specified. No pass counts can be 
specified. 

 
 
 

7.6.3 Command Button 
The buttons on this window has the following meanings. 
 
Button Function 
Reset Discards the contents being displayed in the window and loads contents from the 

emulator in which they were set. 
Save... Saves the contents set in the window to a file. 
Load... Loads event information from a file in which it was saved. 
Set Sends the contents set in the window to the emulator. 
Close Closes the window. 
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7.6.4 Specify the Events (Instruction Fetch) 
To specify an instruction fetch event, change the event select dialog box's Event Type to "FETCH". 
The event is established when instruction is fetched from the specified address or any address in 
the specified address range. 
 

7.6.4.1 Instruction Fetch of Specified Address 

Set as below. 
 
Example) Instruction fetch at address 80000h 

 
 



 

 

7.6.4.2 Instruction Fetch of Specified Address Area(In) 

Set as below. 
 
Example) Instruction fetch at address 80000h to 80FFFh 
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7.6.4.3 Instruction Fetch of Specified Address Area(Out) 

Set as below. 
 
Example) Instruction fetch at any address other than the range 80000h to 80FFFh 

 
 



 

 

7.6.4.4 Entering/exiting to specified function 

Set as below. 
 
Example) Entering a break to function name "wait" 
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Example) Exiting from function name "wait" 

 
 
 



 

7.6.5 Specify the Events (Memory Access) 
To specify a memory access event, change the event select dialog box's Event Type to "DATA 
ACCESS". The event is established when memory is accessed at the specified address or under 
conditions set for the specified address range. 
 
The contents of settings varies depending on the product. Please refer 7.6.6 Memory Access(The 
debugger for M16C/R8C). 
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7.6.6 Memory Access(The debugger for M16C/R8C) 
ATTENTION 
It is not detected that data access to the odd addresses in word-size access.  

7.6.6.1 Writing/Reading a Specified Address 

Set as below. 
Example) Writing to even address 400h  
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Example) Writing byte length data 32h to even address 400h 

 
 

 
 



 

Example) Writing byte length data 32h to odd address 401h 
Contents of settings vary with each product and bus width.  
(8 bits bus width) 
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(16 bits bus width) 

 
 

 



 

Example) Writing word length data 1234h to even address 400h 
Contents of settings vary with each product and bus width.  
 
(8 bits bus width) 
Please specify "And" of the 1st point and the 2nd point for a combination condition. 
1st point 
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2nd point 

 
 

 
 



 

(16 bits bus width) 
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Example) Writing data 10h - 3Fh to even address 400h 

 
 

 
 



 

7.6.6.2 Reading/writing data to the specified address range 

Set as below. 
 
Example) Writing data to addresses ranging from 400h to 40Fh 
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7.6.6.3 Reading/writing data to addresses outside the specified range 

Set as below. 
 
Example) Writing data to addresses below 7FFh 

 
 

 



 

7.6.7 Specify the Events (Bit Access) 
To specify a bit access event, change the event select dialog box's Event Type to "BIT SYMBOL". 
The event is established when the specified bit at the specified address or specified bit symbol is 
accessed under specified conditions. 
 

7.6.7.1 Writing/Reading a Specified Bit 

Set as below. 
 
Example) Writing "0" to bit 2 at address 400h 
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7.6.7.2 Writing/Reading a Specified Bit Symbol 

Set as below. 
 
Example) Writing "1" to bit symbol "bitsym" 

 
 
 



 

7.6.8 Specify the Event Combination Condition 
Use the Combination group of the event setting windows to specify the combinatorial conditions of 
events. 
 
The combination of two or more events can be used. 
One of the following combinatorial conditions can be selected.  
AND All of the specified events are established 
AND(Same Time) The specified events are established at the same time 
OR One of the specified events is established 
Pass counts (number of times passed) can be specified for each event (1-255). If the specified 
combinatorial condition is AND (Same Time), no pass counts can be set (fixed to 1). 
 

7.6.9 Select AND, OR 
Change the Combination group to "AND" to specify AND for the combinatorial condition, or "OR" to 
specify OR for the combinatorial condition. Next, check (turn on) an event in the event specification 
area that you want to use, and specify a pass count for that event. To alter the pass count, while the 
event to alter is being selected, click the pass count value of that event. 
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7.6.10 Select AND(Same Time) 
Change the Combination group to "AND (Same Time)". Next, check (turn on) an event in the event 
specification area that you want to use. No pass counts can be specified (fixed to 1). 

 
 



 

7.7 Address Interrupt Break Point Setting Window 
The Address Interrupt Break Point Setting window allows you to set address interrupt break 
points. 
This function stops the target program immediately before executing an instruction at a specified 
address. This function is realized by using the MCU's address match interrupt. So that the address 
interrupt break function can only be used when the address match interrupt is not used in the user 
application. 
 

 
 This window is available only when the address interrupt break function is used. 

Use the MCU tab in the Init dialog box to specify whether or not to use the address interrupt 
break function. On this tab, select the Enable the Address Match Interrupt Break Function 
check box. 

 The number of address interrupt breakpoints that can be set varies with each product. 
 Breakpoints can be specified by "Address" or "Filename + Line No.". 
 If you have set multiple breakpoints, program execution stops when any one break address is 

encountered (OR conditions). 
 You can clear, enable or disable breakpoints selected by clicking in the breakpoint display area. 

You can also enable and disable breakpoints by double-clicking on them. 
 Click on the "Save" button to save the software break points in the file. To reload software 

break point settings from the saved file, click the "Load" button. 
 If you load breakpoints from a file, they are added to any existing break points. 
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7.7.1 Command Button 
The buttons on this window has the following meanings. 
 
Button Function 
Load... Load setting information from a file in which it was saved. 
Save... Save the contents set in the window to a file. 
Help Display the help of this window. 
Add Add the break point. 
Refer... Open file selection dialog box. 
Close Close the window. 
Delete Remove the selected break point. 
Delete All Remove all break points. 
Enable Enable the selected break points. 
All Enable Enable all break points. 
Disable Disable the selected break point. 
All Disable Disable all break points. 
View Shows the selected breakpoint positions in the Editor(Source) window. 
 
 



 

7.7.2 Setting and Deleting a Break Points from Editor(Source) Window 
The address interrupt break function can only be used when the address match interrupt is not 
used in the user application. 
For details, refer to "1.8 About Address Interrupt Breaks Function" 
 

7.7.2.1 Setting and Deleting a Break Point from Editor(Source) Window 

You can set break points in the Editor(Source) Window. To do so, double-click the break point 
setting area ("Address Match Interrupt Break" column) for the line in which you want to set the 
break. (A blue marker is displayed on the line to which the break point was set.) 
 

 
 
You can delete the break point by double-clicking again in the break point setting area ("Address 
Match Interrupt Break" column). 
 
In the Editor(Source) window, a display of "Address Match Interrupt Break" column is set to 
"Enable" by default. To erase this column, deselect the [Address Match Interrupt Break] check box 
in the dialog box opened by choosing the main menu - [Edit] -> [Define Column Format]. The 
"Address Match Interrupt Break" column is erased from all Editor (Source) windows. And select 
popup menu - [Columns] -> [Address Match Interrupt Break] in the Editor (Source) window, A 
column can be set up for each Editor (Source) windows. 
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7.8 Trace Point Setting Window 
The Trace Point Setting window is used to set trace points. 
 

 
 The events listed below can be specified as trace events. If the contents of events are altered, 

they are marked by an asterisk (*) on the title bar. The asterisks (*) are not displayed after 
setting up the emulator. 
        Fetch, Memory Access, Bit Access 

 Events at up to two points can be used. 
The H/W Break Point Setting window and the Trace Point Setting windows use the same 
resource of the emulator. Use the MCU tab in the Init dialog box, in order to specify for which 
function the resources are used. On this tab, select the Enable the Trace Point Function check 
box.(Details) 

 These events can be combined in one of the following ways: 
 Trace when all of the valid events are established (AND condition) 
 Trace when all of the valid events are established at the same time (simultaneous AND 

condition) 
 Trace when one of the valid events is established (OR condition) 

 



 

 

7.8.1 Specify the Trace Event 
To set events, double-click to select the event you want to set from the event setting area of the 
Trace Point Setting Window. This opens the dialog box shown below. 
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Following events can be set by specifying Event Type in this dialog box. 
 When FETCH is selected 

Traces for the instruction fetch. 
 

 
 
 

 When DATA ACCESS is selected 
Traces for the memory access. 

 
 



 

 
 When BIT SYMBOL is selected 

Traces for the bit access. 

 
 
 

 
114 



7 Windows 

 
115 

7.8.2 Specify the Combinatorial Condition 
To specify a combinatorial condition, specify the desired condition from the combinatorial condition 
specification area. 

 When AND or OR is selected 
In the event specification area, the event used and a pass count for that event can be specified. 
To alter the pass count, while the event to alter is being selected, click the pass count value of 
that event. 

 
 
 

 When AND (Same Time) is selected 
In the event specification area, the event used can be specified. No pass counts can be 
specified. 

 
 
 



 

7.8.3 Specify the Trace Range 
For the compact emulator debugger, 64K cycles equivalent of data can be recorded. 
 

 
Break Stores the 64K cycles (-64K to 0 cycles) to the point at which the target 

program stops.  
Before Stores the 64K cycles (-64K to 1 cycles) to the point at which the trace point is 

passed.  
About Stores the 64K cycles (-32K to 32K cycles) either side of the trace point.  
After Stores the 64K cycles (0 to 64K cycles) of trace data after the trace point.  
Full Stores the 64K cycles (-64K to 0 cycles) of trace data after the trace starts.  
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7.8.4 Specify the Trace Write Condition 
Conditions for cycles to be written to trace memory can be specified. 

 
 
Total Writes all cycles. 
Pick up Writes only the cycles where specified condition holds true. 
Exclude Writes only the cycles where specified condition does not hold true.
 
Also, following three write modes are supported. 

 
Only cycles where specified event is established 

 
Cycles from where specified event is established to where 
specified event is not established 

 
Cycles from where start event is established to where end 
event is established 

 



 

7.8.5 Command Button 
The buttons on this window has the following meanings. 
 
Button Function 
Reset Discards the contents being displayed in the window and loads contents from 

the emulator in which they were set. 
Save... Saves the contents set in the window to a file. 
Load... Loads event information from a file in which it was saved. 
Set Sends the contents set in the window to the emulator. 
Close Closes the window. 
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7.8.6 Specify the write condition 
Trace data write conditions can be specified. 
You can specify the following write conditions: 
 
1. Write conditions unlimited (default) 
2. Cycles from the start event established to the end event established 
3. Only cycles where the start event is established 
4. Cycles from the start event established to the start event unestablished 
5. Other than cycles from the start event established to the end event established 
6. Other than cycles where the start event is established 
7. Other than cycles from the start event established to the start event unestablished 
 
To specify condition 1, choose "Total" from the list box of the window's "Write Condition" item. 
 

 
 
To specify conditions 2 to 4, choose "Pick Up" and click the "Detail..." button to open the 
"Realtime-trace Write Condition" dialog box. 
 

 
 

 For condition 2, choose the Mode shown below and set the Start and End events. 

 
 



 

 
 For condition 3, choose the Mode shown below and set the Start event. 

 
 

 For condition 4, choose the Mode shown below and set the Start event. 
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Similarly, when specifying conditions 5 to 7, choose "Exclude" and click the "Detail..." button to 
open the Realtime-trace Write Condition dialog box. 
 

 
 

 For condition 5, choose the Mode shown below and set the Start and End events. 

 
 

 For condition 6, choose the Mode shown below and set the Start event. 

 
 



 

 For condition 7, choose the Mode shown below and set the Start event. 
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7.9 Trace Window 
The Trace Window is used to display the results of real-time trace measurement. The measurement 
result can be displayed in the following display modes. 

 Bus mode 
This mode allows you to inspect cycle-by-cycle bus information. The display content depends 
on the MCU and emulator system used. In addition to bus information, this mode allows 
disassemble, source line or data access information to be displayed in combination. 

 Disassemble mode 
This mode allows you to inspect the executed instructions. In addition to disassemble 
information, this mode allows source line or data access information to be displayed in 
combination. 

 Data access mode 
This mode allows you to inspect the data read/write cycles. In addition to data access 
information, this mode allows source line information to be displayed in combination. 

 Source mode 
This mode allows you to inspect the program execution path in the source program. 

 
The measurement result is displayed when a trace measurement has finished. When a trace 
measurement restarts, the window display is cleared. 
The range of a trace measurement can be altered in the Trace Point Setting Window. For details 
about this window, refer to "Referencing the Trace Point Setting Window." With default settings, 
the trace information immediately before the program has stopped is recorded. 



 

7.9.1 Configuration of Bus Mode 
When bus mode is selected, trace information is displayed in bus mode. Bus mode is configured as 
shown below. 
The display content in bus mode differs depending on the MCU or emulator system used. 
 

 
 
(1) Cycle display area: Shows trace cycles. Double-click here to bring up a dialog box to change the 
displayed cycle. 
(2) Label display area: Shows labels corresponding to address bus information. Double-click here to 
bring up a dialog box to search for addresses. 
(3) Bus information display area: The content displayed here differs depending on the MCU or 
emulator system used. 
Display of bus information on the M16C/R8C Debugger 
(4) Time information display area: Shows time information of trace measurement result. One of the 
following three modes can be selected from the menu. 
Absolute Time：Shows an elapsed time from the time the program started running up to now in 
terms of absolute time (default). 
Differences：Shows a differential time from the immediately preceding cycle. 
Relative Time：Shows a relative time from the selected cycle. Note, however, that this mode 
changes to the absolute time display mode when the trace measurement result is updated. 
(5) Acquired range of trace measurement result: Shows the currently acquired range of trace 
measurement result. 
(6) Trace measurement range: Shows the currently set range of trace measurement. 
(7) First line cycle: Shows the cycle of the first line displayed. 
(8) First line address: Shows the address of the first line displayed. 
(9) First line time: First line time: Shows the time information of the first line displayed. 
(10) Window splitting box: Double-clicking this box splits the window into parts. 
 
In addition to bus information, the window can display disassemble, source line or data access 
information in combination. In this case, the display will be similar to the one shown below. 
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7.9.2 Configuration of Disassemble Mode 
When disassemble mode is selected while bus mode is unselected, trace information is displayed in 
disassemble mode. Disassemble mode is configured as shown below. 
 

 
 
(1) Address display area: Shows addresses corresponding to instructions. Double-click here to bring 
up a dialog box to search for addresses. 
(2) Object code display area: Shows the object codes of instructions. 
(3) Label display area: Shows labels corresponding to instruction addresses. Double-click here to 
bring up a dialog box to search for addresses. 
(4) Mnemonic display area: Shows the mnemonics of instructions. 
 
Other display areas are the same as in bus mode. 
 
In addition to disassemble information, the window can display source line or data access 
information in combination. In this case, the display will be similar to the one shown below. 
 

 
 



 

 

7.9.3 Configuration of Data Access Mode 
When data access mode is selected while bus mode and disassemble mode are unselected, trace 
information is displayed in data access mode. Data access mode is configured as shown below. 
 

 
(1) Data access display area: Shows data access information. If the information displayed here is 
"000400 1234 W," for example, it means that data "1234H" was written to the address 000400H in 
2-byte width. 
 
Other display areas are the same as in bus mode. 
 
In addition to data access information, the window can display source line information in 
combination. In this case, the display will be similar to the one shown below. 
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7.9.4 Configuration of Source Mode 
When only source mode is selected, trace information is displayed in source mode. Source mode is 
configured as shown below. 
 

 
 
(1) Line number display area: Shows the line number information of the displayed file. Double-click 
here to bring up a dialog box to change the displayed file. 
(2) Address display area: Shows addresses corresponding to source lines. Double-click here to bring 
up a dialog box to search for addresses. 
(3) Referenced cycle display area: Shows the currently referenced cycle that is marked by ">>." 
Furthermore, the addresses corresponding to source lines, if any, are marked by "-." 
(4) Source display area: Shows the content of the source file. 
(5) File name: Shows the file name of the currently displayed source file. 
(6) Referenced cycle: Shows the currently referenced cycle. 
(7) Referenced address: Shows the address corresponding to the currently referenced cycle. 
(8) Referenced time: Shows the time information corresponding to the currently referenced cycle. 
 
Other display areas are the same as in bus mode. 
 
 



 

7.9.5 Extended Menus 
This window has the following popup menus that can be brought up by right-clicking in the 
window. 
 
Menu Function 
BUS Display the information of BUS mode. 
DIS Display the information of Disassemble mode. 
SRC Display the information of Source mode. 
DATA Display the information of Data access mode. 

Cycle... Changes the displayed position by specifying a cycle. 
Address... Changes the displayed position by searching an address. 

View 

Source... Display a selected source file. 
Absolute Time Shows elapsed time from the time the program started 

running up to now in terms of absolute time. 
Differences Shows a differential time from the immediately preceding 

displayed cycle. 

Time 

Relative Time Shows a relative time from the currently selected cycle. 
Forward Changes the direction of search to forward direction. 
Backward Changes the direction of search to reverse direction. 
Step Searches in Step mode in the specified direction of search.
Come Searches in Come mode in the specified direction of 

search. 
Stop Stops trace measurement in the middle and displays the 

measured content at the present point of time. 

Trace 

Restart Restarts trace measurement. 
Layout... Change layout of the corrent view. 
Copy Copy selected lines. 
Save... Save trace data to file. 
Load... Load trace data from file. 
Toolbar display Display toolbar. 
Customize toolbar... Open toolbar customize dialog box. 
Allow Docking Allow window docking. 
Hide Hide window. 
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7.9.6 Display of bus information on the M16C/R8C Debugger 
From left to right, the contents are as follows: 

 Address 
The status of the address bus 

 Data 
The status of the data bus 

 BUS 
The width of the external data bus ("8b" for an 8-bit data bus, and "16b" for a 16-bit data bus) 

 BHE 
Indicates the status (0 or 1) of the BHE (Byte High Enable) signal. 
If BHE = 0, it means that the CPU is accessing an odd address. 

 BIU 
This shows the status between the BIU (bus interface unit) and memory, and BIU and I/O.  

Representation BIU status 
- No access 
DMA Data access other than a CPU cause such as 

DMA 
INT Start of INTACK sequence 
IB Instruction code read due to CPU cause (bytes) 
DB data access due to CPU cause (bytes) 
IW Instruction code read due to CPU cause (words) 
DW data access due to CPU cause (words) 
 

 R/W 
Shows the status of the data bus ("R" for r ead, "W" for wr it e, "-" for no access). 

 RWT 
This signal shows the effective position in the bus cycle ("0" when effective. Address, Data, and 
BIU signals are valid when RWT is "0". 

 CPU 
This shows the signal between CPU and BIU.  

Representation Status 
- No accessing 
CB Opecode read (bytes) 
RB Operand read (bytes) 
QC Instruction queue buffer clear 
CW Opecode read (words) 
RW Operand read (words) 
 



 

7.10 GUI I/O Window 
The GUI I/O window allows you for port input by creating a user target system key input panel 
(button) in the window and clicking the created button. And this window also allows you to 
implement the user target system output panel in the window. 

 
 

 You can arrange the following parts on the window. 
 Label (character string) 

Displays/erases a character string specified by the user when any value is written to the 
specified address (bit). 

 LED 
Changes the display color of any area when any value is written to the specified address 
(bit). (Substitution for LED ON) 

 Button 
A virtual port input can be executed at the time the button is pressed. 

 Text 
Display the text string. 

 You can also save the created panel in a file and reload it. 
 You can set up to 200 address points to the created part. If different addresses are set to the 

individual parts, you can arrange up to 200 parts. 
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7.10.1 Extended Menus 
This window has the following popup menus that can be brought up by right-clicking in the 
window. 
 
Menu Function 
Select Item Select an I/O item. 
Delete Delete the selected I/O item. 
Copy Copy the selected I/O item. 
Paste Paste the copied I/O item. 
Create Button Create a new button item. 
Create Label Create a new label item. 
Create LED Create a new LED item. 
Create Text Create a new text item. 
Display grid Display the grid line. 
Save... Save I/O panel file. 
Load... Load I/O panel file. 
Sampling Period... Set RAM monitor sampling period. 
Toolbar display Display toolbar. 
Customize toolbar... Open toolbar customize dialog box. 
Allow Docking Allow window docking. 
Hide Hide window. 
 
 



 

8. Table of Script Commands 

8.1 Table of Script Commands 
The following script commands are prepared. 
The commands with yellow color displaying can be executed at run time. 
The command to which "*" adheres behind is not supported according to the product. 
 
Please refer to "8.2 Table of Script Commands (alphabetical order) " when searching in alphabetical 
order. 
 

8.1.1 Execution Commands 
Command Name Short Name Contents 
Go G Program execution with breakpoints  
GoFree GF Free run program execution  
GoProgramBreak* GPB Run target program with software break point 
GoBreakAt* GBA Run target program with software break point 
Stop - Stops program execution  
Sta us t - Checks the operating status of the MCU  
Step S Halts for user input until the specified time has elapsed  
StepInstruction SI Step execution of instructions  
OverStep O Overstep execution of source lines  
OverStepInstruaction OI Overstep execution of instructions  
Return RET Executes a source line return  
ReturnInstruction RETI Executes an instruction return  
Reset - Resets the target MCU  
Time - Sets the run time display and checks the current setting  
 
 

8.1.2 File Operation Commands 
Command Name Short Name Contents 
Load L Downloads the target program  
LoadHex LH Downloads an Intel HEX-format file  
LoadMot* LM Downloads a Motorola S-format file 
LoadSymbol LS Loads source line/ASM symbol information  
Reload - Re-downloads the target program  
UploadHex UH Outputs data to an Intel HEX-format file  
UploadMot* UM Outputs data to a Motorola S-format file 
 

8.1.3 Register Operation Commands 
Command Name Short Name Contents 
Register R Checks and sets a register value 
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8.1.4 Memory Operation Commands 
Command Name Short Name Contents 
DumpByte DB Displays the contents of memory (in 1-byte units)  
DumpWord* DW Displays the contents of memory (in 2-byte units) 
DumpLword* DL Displays the contents of memory (in 4-byte units) 
SetMemoryByte MB Checks and changes memory contents (in 1-byte units)  
SetMemoryWord* MW Checks and changes memory contents (in 2-byte units) 
SetMemoryLword* ML Checks and changes memory contents (in 4-byte units) 
FillByte FB Fills a memory block with the specified data (in 1-byte 

units)  
FillWord* FW Fills a memory block with the specified data (in 2-byte 

units) 
FillLword* FL Fills a memory block with the specified data (in 4-byte 

units) 
Move - Moves memory blocks  
MoveWord* MOVEW Moves memory blocks(in 2-byte units) 
 

8.1.5 Assemble/Disassemble Commands 
Command Name Short Name Contents 
Assemble A Line-by-line assembly  
DisAssemble DA Disassembles memory contents line by line  
Module MOD Displays modules names  
Scope - Sets and checks the effective local symbol scope  
Section SEC Checks section information  
Bit* - Checks and sets bit symbols 
Symbol SYM Checks assembler symbols  
Label - Checks assembler labels  
Express EXP Displays an assembler expression  
 
 

8.1.6 Software Break Setting Commands 
Command Name Short Name Contents 
SoftwareBreak SB Sets and checks software breaks  
SoftwareBreakClear SBC Clears software breaks  
SoftwareBreakClearAll SBCA Clears all software breaks  
SoftwareBreakDisable SBD Disables software breakpoints  
SoftwareBreakDisableAll SBDA Disables all software breaks  
SoftwareBreakEnable SBE Enables software breakpoints  
SoftwareBreakEnableAll SBEA Enables all software breaks  
BreakAt - Sets a software breakpoint by specifying a line No.  
BreakIn - Sets a software breakpoint by specifying a function  
 
 

8.1.7 Address Interrupt Break Setting Commands 
Command Name Short Name Contents 
ADdressInterruptBreak ADIB Sets and checks the address interrupt break 
 



 

8.1.8 Hardware Break Setting Commands 
Command Name Short Name Contents 
HardwareBreak HB Sets and checks a hardware break  
BreakMode BM Sets and checks hardware break mode 
 

8.1.9 Real-time Trace Commands 
Command Name Short Name Contents 
TracePoint TP Sets and checks a trace points  
TraceData TD Realtime trace data display  
TraceList TL Displays disassembled realtime trace data  
 

8.1.10 Script/Log File Commands 
Command Name Short Name Contents 
Script - Opens and executes a script file 
Exit - Exits the script file 
Wait - Waits for an event to occur before command input  
Pause - Waits for user input 
Sleep - Halts for user input until the specified time has elapsed  
Logon - Outputs the screen display to a log file 
Logoff - Stops the output of the screen display to a log file 
Exec - Executes external application 
 

8.1.11 Program Display Commands 
Command Name Short Name Contents 
Func - Checks function names and displays the contents of 

functions  
Up* - Displays the calling function 
Down* - Displays a called function 
Where* - Displays a function call status 
Path - Sets and checks the search path  
AddPath - Adds the search path 
File - Checks a filename and displays the contents of that file  
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8.1.12 Clock Command 
Command Name Short Name Contents 
Clock CLK Checks and changes the clock 
 

8.1.13 C Language Debugging Commands 
Command Name Short Name Contents 
Print - Check value of specified C variable expression 
Set - Set specified data in specified C variable expression 
 

8.1.14 Real-time OS Command 
Command Name Short Name Contents 
MR* - Displays status of realtime OS (MRxx) 
 

8.1.15 Utility Commands 
Command Name Short Name Contents 
Radix - Sets and checks the radix for numerical input 
Alias - Specifies and checks command alias definitions 
UnAlias - Cancels the alias defined for a command 
UnAliasAll - Cancels all aliases defined for commands 
Version VER Displays the version No.  
Date - Displays the date  
Echo - Displays messages  
CD - Window open 
 
 



 

8.2 Table of Script Commands (alphabetical order) 
The following script commands are prepared. 
The commands with yellow color displaying can be executed at run time. 
The command to which "*" adheres behind is not supported according to the product. 
 
Command Name Short Name Contents 
AddPath - Adds the search path 
ADdressInterruptBreak ADIB Sets and checks the address interrupt break 
Alias - Specifies and checks command alias 

definitions 
Assemble A Line-by-line assembly  
Bit* - Checks and sets bit symbols 
BreakAt - Sets a software breakpoint by specifying a line 

No. 
BreakIn - Sets a software breakpoint by specifying a 

function  
BreakMode BM Sets and checks hardware break mode 
CD - Specifies and checks the current directory  
Clock CLK Checks and changes the clock  
Date - Displays the date  
DisAssemble DA Disassembles memory contents line by line  
Down* - Displays a called function 
DumpByte DB Displays the contents of memory (in 1-byte 

units) 
DumpLword* DL Displays the contents of memory (in 4-byte 

units) 
DumpWord* DW Displays the contents of memory (in 2-byte 

units) 
Echo - Displays messages  
Exec - Executes external application 
Exit - Exits the script file 
Express EXP Displays an assembler expression  
File - Checks a filename and displays the contents of 

that file  
FillByte FB Fills a memory block with the specified data 

(in 1-byte units)  
FillLword* FL Fills a memory block with the specified data 

(in 4-byte units) 
FillWord* FW Fills a memory block with the specified data 

(in 2-byte units) 
Func - Checks function names and displays the 

contents of functions  
Go G Program execution with breakpoints  
GoBreakAt* GBA Run target program with software break point
GoFree GF Free run program execution  
GoProgramBreak* GPB Run target program with software break point
HardwareBreak HB Sets and checks a hardware break  
Label - Checks assembler labels  
Load L Downloads the target program 
LoadHex LH Downloads an Intel HEX-format file  
LoadMot* LM Downloads a Motorola S-format file 
LoadSymbol LS Loads source line/ASM symbol information  
Logoff - Stops the output of the screen display to a log 

file 
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Logon - Outputs the screen display to a log file 
Module MOD Displays modules names  
Move - Moves memory blocks  
MoveWord* MOVEW Moves memory blocks(in 2-byte units) 
MR* - Displays status of realtime OS (MRxx) 
OverStep O Overstep execution of source lines  
OverStepInstruaction OI Overstep execution of instructions  
Path - Sets and checks the search path 
Pause - Waits for user input  
Print - Check value of specified C variable expression. 
Radix - Sets and checks the radix for numerical input 
Register R Checks and sets a register value  
Reload - Re-downloads the target program  
Reset - Resets the target MCU 
Return RET Executes a source line return  
ReturnInstruction RETI Executes an instruction return  
Scope - Sets and checks the effective local symbol 

scope 
Script - Opens and executes a script file 
Section SEC Checks section information  
Set - Set specified data in specified C variable 

expression 
SetMemoryByte MB Checks and changes memory contents (in 

1-byte units)  
SetMemoryLword* ML Checks and changes memory contents (in 

4-byte units) 
SetMemoryWord* MW Checks and changes memory contents (in 

2-byte units) 
Sleep - Halts for user input until the specified time 

has elapsed  
Softwa eBreak r SB Sets and checks software breaks  
SoftwareBreakClear SBC Clears software breaks  
SoftwareBreakClearAll SBCA Clears software breaks  
SoftwareBreakDisable SBD Disables software breakpoints  
SoftwareBreakDisableAll SBDA Disables all software breaks  
SoftwareBreakEnable SBE Enables software breakpoints  
SoftwareBreakEnableAll SBEA Enables all software breaks  
Statu  s - Checks the operating status of the MCU  
Step S Step execution of source line  
StepInstruction SI Step execution of instructions  
Stop - Stops program execution  
Symbol SYM Checks assembler symbols  
Time - Sets the run time display and checks the 

current setting  
TraceData TD Realtime trace data display  
TraceList TL Displays disassembled realtime trace data  
TracePoint TP Sets and checks a trace points  
UnAlias - Cancels the alias defined for a command  
UnAliasAll - Cancels all aliases defined for commands  
Up* - Displays the calling function 
UploadHex UH Outputs data to an Intel HEX-format file  
UploadMot* UM Outputs data to a Motorola S-format file 
Version VER Displays the version No.  
Wait - Waits for an event to occur before command 

input  
Where* - Displays a function call status 



 

9. Writing Script Files 

This debugger allows you to run script files in a Script Window. The script file contains the controls 
necessary for automatically executing the script commands. 
 

9.1 Structural Elements of a Script File 
You can include the following in script files: 
 

 Script commands 
 Assign statements 
 Conditional statements (if, else, endi) 

Program execution branches to the statement(s) to be executed according to the result of the 
conditional expression. 

 Loop statements (while, endw) 
A block of one or more statements is repeatedly executed according to the expression. 

 break statement 
Exits from the innermost loop. 

 Comment statements 
You can include comments in a script file. The comment statements are ignored when the 
script commands are executed. 

 
Specify only one statement on each line of the script file. You cannot specify more than one 
statement on a line, or write statements that span two or more lines. 
 

Notes 
 You cannot include comments on the same lines as script commands. 
 You can nest script files up to five levels. 
 You can nest if statements and while statements up to 32 levels. 
 If statements must be paired with endi statements, and while statements with endw 

statements in each script file. 
 Expressions included in script files are evaluated as unsigned types. Therefore, operation 

cannot be guaranteed if you use negative values for comparison in if or while statements. 
 You can specify up to 4096 characters per line. An error occurs if a line exceeds this number of 

characters. 
 When a script file containing illegal commands is automatically executed (when you select 

[ Option ] -> [Script]-> [ Run ] from the Script Window menu after opening a script file, or click 
the  button in the Script Window), execution of the script file continues even after the error is 
detected, except when the script line itself cannot be read. If an error is detected and the script 
file continues to be executed, operation after detection of the error cannot be guaranteed. 
Reliability cannot therefore be placed on the results of execution after an error has been 
detected. 
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Script Command 
You can use the same script commands that you enter in the Script Window. You can also call 
script files from within other script files (nesting up to 10 levels). 
 
Assign Statement 
Assign statement s define and initialize macro variables and assign values. The following shows 
the format to be used. 
 
%macro-variable = expression 
 

 You can use alphanumerics and the underscore (_) in macro variable names. However , you 
cannot use a numeric to start a macro variable name. 

 You can specify any expression of which the value is an integer between 0h and FFFFFFFFh 
to be assigned in a macro variable. If you specify a negative number, it is processed as twos 
complement. 

 You can use macro variables within the expression. 
 Always precede macro variables with the "%" sign. 

 
Conditional Statement 
In a conditional statement, different statements are executed according to whether the condition is 
true or false. The following shows the format to be used. 
 
if ( expression ) 
 statement 1 
else 
 statement 2 
endi  
 

 If the expression is t rue (other than 0), statement 1 is executed. If false, (0), statement 2 is 
executed. 

 You can omit the else statement. If omitted and the expression is false, execution jumps to the 
line after the endi statement. 

 if statements can be nested (up to 32 levels). 
 
Loop Statement(while,endw) and Break Statement 
In loop statements, execution of a group of statements is repeated while the expression is true. The 
following shows the format to be used. 
 
while ( expression ) 
 statement 
endw  
 

 If the expression is t rue, the group of statements is repeated. If false, the loop is exited (and 
the statement following the endw statement is executed). 

 You can nest while statements up to 32 levels. 
 Use the break statement to forcibly exit a while loop. If while statements are nested, break 

exits from the inner most loop. 
 



 

Comment statements 
You can include comments in a script file. Use the following format. 
 
;character string  
 
Write the statement after a semicolon (;). You can include only spaces and tabs in front of the 
semicolon 
Lines with comment statements are ignored when the script file is executed. 
 

9.2 Writing Expressions 
This debugger allows you to use expressions for specifying addresses, data, and number of passes, 
etc. The following shows example commands using expressions. 
>DumpByte TABLE1 
>DumpByte TABLE1+20 
You can use the following elements in expressions: 

 Constants 
 Symbols and labels 
 Macro variables 
 Register variables 
 Memory variables 
 Line Nos. 
 Character constants 
 Operators 

 
Constants 
You can use binary, octal, decimal, or hexadecimals. The prefix or suffix symbol attached to the 
numerical value indicates which radix is used. 
The debugger for M32C and M16C/R8C 
 Hexadecimal Decimal Octal Binary * 
Prefix 0x,0X @ None % 
Suffix h,H None o,O b,B 
Examples 0xAB24 

AB24h 
@1234 1234o %10010 

10010b 
*You can only specify % when the predetermined radix is hexadecimal. 
 

 If you are inputting a radix that matches the predetermined radix, you can omit the symbol 
that indicates the radix (excluding binary). 

 Use the RADIX command to set the predetermined value of a radix. However, in the cases 
shown below, the radix is fixed regardless of what you specify in a RADIX command. 

 
Type Radix 
Address Hex 
Line No. 
No. of executions 
No. of passes 

Dec 
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Symbols and labels 
You can include symbols and labels defined in your target program, or symbols and labels defined 
using the Assemble command. 

 You can include alphanumerics, the underscore (_), period (.), and question mark (?) in 
symbols and labels. However, do not start with a numeric. 

 Symbols and labels can consist of up to 255 characters. 
 Uppercase and lowercase letters are unique. 
 You cannot include the assembler as30 structured instructions, pseudo instructions, macro 

instructions, operation code, or reserved words (.SECTION, .BYTE, switch, if, etc.). 
 You cannot use strings that start with two periods (..) for symbols or labels. 

Product Name Notes 
The debugger for M32R, 
The debugger for M32C, 
The debugger for M16C/R8C, 

You cannot include the assembler structured instructions, pseudo 
instructions, macro instructions, operation code, or reserved words 
(.SECTION, .BYTE, switch, if, etc.). 
You cannot use strings that start with two periods (..) for symbols or 
labels.  

 
Local label symbol and scope 
This debugger supports both global label symbols, which can be referenced from the whole program 
area, and local label symbols, which can only be referenced within the file in which they are 
declared. The effective range of local label symbols is known as the scope, which is measured in 
units of object files. The scope is switched in this debugger in the following circumstances: 

 When a command is entered 
The object file that includes the address indicated by the program counter becomes the current 
scope. When the SCOPE command is used to set the scope, the specified scope is the active 
scope. 

 During command execution 
The current scope automatically switches depending on the program address being handled by 
the command. 

 
Priority levels of labels and symbols 
The conversion of values to labels or symbols, and vice versa, is subject to the following levels of 
priority: 

 Conversion of address values 
1. Local labels 
2. Global labels 
3. Local symbols 
4. Global symbols 
5. Local labels outside scope 
6. Local symbols outside scope 

 
 Conversion of data values 

1. Local symbols 
2. Global symbols 
3. Local labels 
4. Global labels 
5. Local symbols outside scope 
6. Local labels outside scope 

 
Conversion of bit values 

1. Local bit symbols 
2. Global bit symbols 
3. Local bit symbols outside scope (excluding the debugger for M16C/R8C) 



 

Macro Variables 
Macro variables are defined by assign statements in the script file. See section "9.1 Structural 
Elements of a Script File " in the Reference part for details. Precede variables with '%' for use as 
macro variables. 
You can specify alphanumerics and/or the underbar (_) in the variable name following the percent 
sign (%). However , do not star t the names with a numeric. 

 You cannot use the names of registers as variable names. 
 Uppercase and lowercase letters are differentiated in variable names. 
 You can define a maximum of 32 macro variables. Once defined, a macro variable remains 

valid until you quit the debugger. 
Macro variables are useful for specifying the number of iterations of the while statement. 
 
Register variables 
Register variables are used for using the values of registers in an expression. Precede the name of 
the register with '%' to use it as a register variable. Use the following format. 
Product Name Register name 
The debugger for M16C/R8C  PC, USP, ISP, SB, INTB, FLG 

0R0, 0R1, 0R2, 0R3, 0A0, 0A1, 0FB <- Bank 0 Register 
1R0, 1R1, 1R2, 1R3, 1A0, 1A1, 1FB <- Bank 1 Register 

Uppercase and lowercase letters are not unique in register names. You can specify either. 
 
Memory variables 
Use memory variables to use memory values in expressions. The format is as follows: 

[Address］.data-size 
 You can specify expressions in addresses (you can also specify memory variables). 
 The data size is specified as shown in the following table.  

data Length Debugger Specification 
1 Byte All B or b 

The debugger for M32R  H or h 2 Bytes 
Other W or w 
The debugger for M32R  W or w 4 bytes 
The debugger for M32R, M16C/R8C  L or l 

Example: Referencing the contents of memory at address 8000h in 2 bytes 
[0x8000].W 
 

 The default data size is word, if not specified. 
 
Line Nos. 
These are source file line Nos. The format for line Nos. is as follows: 

#line_no 
#line_no."source file name" 

 Specify line Nos. in decimal. 
 You can only specify line Nos. in which software breaks can be set. You cannot specify lines in 

which no assembler instructions have been generated, including comment lines and blank 
lines. 

 If you omit the name of the source file, the line Nos. apply to the source file displayed in active 
Editor(Source) Window. 

 Include the file attribute in the name of the source file. 
 Do not include any spaces between the line No. and name of the source file. 
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Character constants 
The specified character or character string is converted into ASCII code and processed as a 
constant. 

 Enclose characters in single quote marks. 
 Enclose character strings in double quote marks. 
 The character string must consist of one or two characters (16 bits max.). If more than two 

characters are specified, the last two characters of the string are processed. For example, 
"ABCD" would be processed as "CD", or value 4344h. 

 
Operators 
The table below lists the operators that you can use in expressions. 

 The priority of operators is indicated by the level, level 1 being the highest and level 8 the 
lowest. If two or more operators have the same level of priority, they are evaluated in order 
from the left of the expression. 

Operator Function Priority level 
( ) Brackets level 1 
+, -, ~ Monadic positive, monadic negative, monadic logical NOT level 2 
*, / Dyadic multiply, dyadic divide level 3 
+, - Dyadic add, dyadic subtract level 4 
>>,  Right shift, left shift level 5 
& Dyadic logical AND level 6 
|, ^ Dyadic logical OR, dyadic exclusive OR level 7 
<, <=, >, >=, ==, != Dyadic comparison level 8 
 



 

10. C/C++ Expressions 

10.1 Writing C/C++ Expressions 
You can use C/C++ expressions consisting of the tokens shown below for registering C watchpoints 
and for specifying the values to be assigned to C watchpoints. 
 
Token Example 
Immediate values 10, 0x0a, 012, 1.12, 1.0E+3 
Scope ::name, classname::member 
Mathematical operators +, -, *, / 
Pointers *, **, ... 
Reference & 
Sign inversion - 
Member reference using comma Object.Member 
Member reference using arrow Pointer->Member, this->Member 
Pointers to Members Object.*var, Pointer->*var 
Parentheses (, ) 
Arrays Array[2], DArray[2] [3] , ... 
Casting to basic types (int), (char*), (unsigned long *), ... 
Casting to typedef types (DWORD), (ENUM), ... 
Variable names and function names var, i, j, func, ... 
Character constants 'A', 'b', ... 
Character string literals "abcdef", "I am a boy.", ... 
 
Immediate Values 
You can use hexadecimals, decimals, octals as immediate values. Values starting with 0x are 
processed as hexadecimals, those with 0 as octals, and those without either prefix as decimals. 
Floating-point numbers can also be used to assign values to variables. 
 

Notes 
 You cannot register only immediate values as C watchpoints. 
 The immediate value is effective only when it is used in C/C++ language expressions that 

specify C/C++ watchpoints or when it is used to specify the value to be assigned to those 
expressions. When using floating-point numbers, operation cannot be performed on an 
expression like 1.0+2.0. 

 
Mathematical Operators 
You can use the addition (+), subtraction (-), multiplication (*), and division (/) mathematical 
operators. The following shows the order of priority in which they are evaluated. 

(*), (/), (+), (-) 

Notes 
 There is no support currently for mathematical operators for floating point numbers. 
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Pointers 
Pointers are indicated by the asterisk (*). You can use pointer to pointers **, and pointer to pointer 
to pointers ***, etc. 
Examples: "*variable_name", "**variable_name", etc. 
 

Notes 
Immediate values cannot be processed as pointers. That is, you cannot specify *0xE000, for 
example. 
 
Reference 
References are indicated by the ampersand (&). You can only specify "&variable_name". 
 
Sign Inversion 
Sign inversion is indicated by the minus sign (-). You can only specify "-immediate_value" or 
"-variable_name". No sign inversion is performed if you specify 2 (or any even number of) minus 
signs. 
 

Notes 
There is no support currently for sign inversion of floating point numbers. 
 
Member Reference Using Comma 
You can only use "variable_name.member_name" for checking the members of structures and 
unions using the comma. 

Example: 
class T { 
public: 
int member1; 
char member2; 

}; 
class T t_cls; 
class T *pt_cls = &t_cls; 

In this case, t_cls.member1, (*pt_cls).member2 correctly checks the members. 
 
Member Reference Using Arrow 
You can only use "variable_name->member_name" for checking the members of structures and 
unions using the arrow. 

Example: 
class T { 
public: 
int member1; 
char member2; 

}; 
class T t_cls; 
class T *pt_cls = &t_cls; 

In this case, (&t_cls)->member1, pt_cls->member2 correctly checks the members. 
 



 

Pointers to Members 
 
Pointers to members using the ".*" or "->*" operator can be refered only in the forms of variable 
name .* member name or variable name ->* member name. 

Example: 
class T { 

public: 
int member; 

}; 
class T t_cls; 
class T *pt_cls = &t_cls; 

 
int T::*mp = &T::member; 

 
In this case, t_cls.*mp and tp_cls->*mp can correctly reference the variable of pointer-to-member 
type. 
 

Note 
Note that the expression *mp cannot considered as the variable of pointer-to-member type. 
 
Parentheses 
Use the '(' and ')' to specify priority of calculation within an expression. 
 
Arrays 
You can use the ' [ ' and ' ] ' to specify the elements of an array. You can code arrays as follows: 
"variable_name [ (element_No or variable) ] ", "variable_name [ (element_No or variable) ] 
[ (element_No or variable) ] ", etc. 
 
Casting to Basic Types 
You can cast to C basic types char, short, int, and long, and cast to the pointer types to these basic 
types. When casting to a pointer type, you can also use pointers to pointers and pointers to pointers 
to pointers, etc. 
Note that if signed or unsigned is not specified, the default values are as follows: 
Basic type Default 
char unsigned 
short signed 
int signed 
long signed 
 

Notes 
Of the basic types of C++, casts to bool type, wchar_t type, and floating-point type (float or double) 
cannot be used. 
Casts to register variables cannot be used. 
 
Casting to typedef Types 
You can use casting to typedef types (types other than the C basic types) and the pointer types to 
them. When casting to a pointer type, you can also use pointers to pointers and pointers to pointers 
to pointers, etc. 
 

Notes 
You cannot cast to struct or union types or the pointers to those types. 
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Variable Names and Function Names 
Function names that begin with English alphabets as required under C conventions can be used. In 
the case of C++, no function names can be used. 
 
Character Constants 
You can use characters enclosed in single quote marks (') as character constants. For example, 'A', 
'b' , etc. These character constants are converted to ASCII code and used as 1-byte immediate 
values. 
 

Notes 
You cannot register character constants only as C watchpoints. 
Character constants are valid only when used in a C/C++ expression that specifies a C watchpoint, 
and when specifying a value to be assigned (character constants are processed in the same manner 
as immediate values). 
 
Character String Literals 
You can use character strings enclosed in double quote marks (") as character string literals. 
Examples are "abcde", "I am a boy.", etc. 
 
Notes 
Character string literals can only be placed on the right side of an assignment operator in an 
expression. They can only be used when the left side of the assignment operator is a char array or a 
char pointer type. In all other cases, a syntax error results. 
 

10.2 Display Format of C/C++ Expressions 
C/C++ expressions in the data display areas of the C Watch Windows are displayed as their type 
name, C/C++ expression (variable name), and result of calculation (value), as shown below. 
The following describes the display formats of the respective types. 
 
Enumeration Types 

 When the result (value) of calculation has been defined, its name is displayed. 
(DATE) date = Sunday(all Radices) 

 If the result (value) of calculation has not been defined, it is displayed as follows: 
(DATE) date = 16 (when Radix is in initial state) 
(DATE) date = 0x10(when Radix is hex) 
(DATE) date = 0000000000010000B(when Radix is binary) 

 



 

Basic Types 
 When the result of calculation is a basic type other than a char type or floating point type, it is 

displayed as follows: 
(unsigned int) i = 65280(when Radix is in initial state) 
(unsigned int) i = 0xFF00(when Radix is hex) 
(unsigned int) i = 1111111100000000B(when Radix is binary) 

 When the result of calculation is a char type, it is displayed as follows: 
(unsigned char) c = 'J'(when Radix is in initial state) 
(unsigned char) c = 0x4A(when Radix is hex) 
(unsigned char) c = 10100100B(when Radix is binary) 

 When the result of calculation is a floating point, it is displayed as follows: 
(double) d = 8.207880399131839E-304(when Radix is in initial state) 
(double) d = 0x10203045060708(when Radix is hex) 
(double) d = 0000000010.....1000B(when Radix is binary) 
(..... indicates abbreviation) 

 
Pointer Types 
 

 When the result of calculation is a pointer type to other than a char* type, it is displayed in 
hexadecimal as follows: 
(unsigned int *) p = 0x1234(all Radices) 

 When the result of calculation is a char* type, you can select the display format of the string 
or a character in the C Watch window’s menu [Display String]. 
・ string types 
(unsigned char *) str = 0x1234 "Japan"(all Radices) 

・ character types 
(unsigned char *) str = 0x1234 (74 'J')(all Radices) 

 
When the result of calculation is a char* type, it is displayed as follows: 
(unsigned char *) str = 0x1234 "Jap(all Radices) 
 
If the string contains a non-printing code prior to the code to show the end of the string (0), it is 
displayed up to the non-printing character and the closing quote mark is not displayed. 

 
You can double-click on lines indicated by a '+' to see the members of that structure or union. The 
'+' changes to a '-' while the members are displayed. To return to the original display, double click 
the line, now indicated by the '-'. 

 
148 



10 C/C++ Expressions 

 
149 

Array Types 
1. When the result of calculation is an array type other than a char [ ] type, the starting address 

is displayed in hex as follows: 
(signed int [10]) z = 0x1234(all Radices) 

_ 
2. When the result of calculation is a char [ ] type, it is displayed as follows: 

(unsigned char [10]) str = 0x1234 "Japan"(all Radices) 
 
If the string contains a non-printing code prior to the code to show the end of the string (0), it is 
displayed up to the non-printing character and the closing quote mark is not displayed. 
(unsigned char [10]) str = 0x1234 "Jap(all Radices) 
 
Also if the string contains more than 80 characters, the closing quote mark is not displayed. When 
the C/C++ expression is an array type as same as pointer type, a '+' is display to the left of the type 
name. You can see the elements of the array by using this indicating (for the details, refer Pointer 
types). When the number of the array elements is more than 1000, the following dialog box open. 
Specify the number of the elements in the dialog box. 
 
 

 
The elements from the index specified in "Start" to the index specified in "End" are displayed. If you 
specify the value more than the max index of the array, the value is regarded as max index of the 
array. When you click the "Cancel" button, the elements are not displayed. 
 
 
Function Types 
When the result of calculation is a function type, the starting address is displayed in hex as follows: 
(void()) main = 0xF000(all Radices) 
_ 
Reference Types 
When the result of calculation is a reference type, the reference address is displayed in hex as 
follows: 
(signed int &) ref = 0xD038(all Radices) 
 
Bit Field Types 
When the result of calculation is a bit field type, it is displayed as follows: 
(unsigned int :13) s.f = 8191(when Radix is in initial state) 
(unsigned int :13) s.f = 0x1FFF(when Radix is hex) 
(unsigned int :13) s.f = 1111111111111B(when Radix is binary) 
 



 

When No C Symbol is Found 
If the calculated expression contained a C symbol that could not be found, it is displayed as follows: 
() x = <not active> (all Radices) 
 
Syntax Errors 
When the calculated expression contains a syntax error, it is displayed as follows: 
() str*(p = <syntax error>(all Radices) 
(where str*(p is the syntax error) 
 
Structure and Union Types 
When the result of calculation is a structure or union type, the address is displayed in hex as 
follows: 
(Data) v = 0x1234 (all Radices) 
 
If, as in structures and unions, the C/C++ expression consists of members, a '+' is displayed to the 
left of the type name (tag name). 

 
You can double-click on lines indicated by a '+' to see the members of that structure or union. The 
'+' changes to a '-' while the members are displayed. To return to the original display, double click 
the line, now indicated by the '-'. This function allows you to check the members of structures and 
unions. 
 

Attention 
If a variable is declared with the same name as the type definition name declared by typedef, you 
cannot reference that variable. 
 
Register Variables 
When the result of calculation is a register variable, "register" is displayed to the left of the type 
name as follows: 
(register signed int) j = 100 
 

 
150 



10 C/C++ Expressions 

 
151 

11. Display the Cause of the Program Stoppage 

If the program is stoped by the debug function, the cause of the stoppage is displayed in the Output 
window or Status window ([Platform] sheet). 
 
The contents of a display and the meaning of "the cause of the stoppage" are as follows. 
Display The cause of the stoppage 
Halt The stop by the [Halt Program] button/menu 
S/W break Software break 
Address match interrupt break Address interrupt break 
H/W event, Combination Hardware break, logical combination AND or AND(same 

time)condition was met 
H/W event, Combination, Ax Hardware break, logical combination OR condition was met 

(Ax: The event number of which condition was met.) 
H/W event, State transition, from xx Hardware break, State Transition condition was met 

(from xx: previous state (start, state1, state2)) 
H/W event, State transition, Timeout Hardware break, State Transition, Time Out condition was 

met 
H/W event, Access protect error Protect break 
 

Note 
To be able to show the cause of break or not depends on the connected target. Some targets may 
always show "Halt" or show "---". 
 



 

12. Attention 

12.1 Common Attention 
A common attention to the product are shown below. 

 File operation on Windows 
 Area where software breakpoint can be set 
 Get or set C variables 
 Function name in C++ 
 Debugging multi modules 
 Syncronized debugging 
 Compact Emulator reset switch 

 

12.1.1 File operation on Windows 
The following points should be noted: 
1. File Name and Directory Name 

 Do not use directory names or filenames that include blanks. 
 Operation is not guaranteed if your directory names and filenames include kanji. 
 Use only one period in a filename. 

 
2. Specify the File and Directory 

 You cannot use "..." to specify two levels upper directories. 
 You cannot use a network pathname. You must allocate a drive. 

 

12.1.2 Area where software breakpoint can be set 
The area which can be set for software breakpoint varies depending on the type of MCU. 
Please refer to "1.6.2 Area where software breakpoint can be set" for details. 
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12.1.3 Get or set C variables 
 If a variable is declared with the same name as the type definition name declared by typedef, 

you cannot reference that variable. 
 Values cannot be changed for register variables and bit fields. 
 Values cannot be changed for 64 bit width variables (long long, double, and so on). 
 Values cannot be changed for C/C++ expressions that do not indicate the memory address and 

size. 
 For the sake of optimization, the C compiler may place different variables at the same address. 

In this case, values of the C variable may not be displayed correctly. 
 Literal character strings can only be substituted for char array and char pointer type 

variables. 
 No arithmetic operations can be performed on floating point types. 
 No sign inversion can be performed on floating point types. 
 Casting cannot be performed on floating point types. 
 Casting cannot be performed on register variables. 
 Casting cannot be performed on structure types, union types, or pointer types to structure or 

union types. 
 Character constants and literal character strings cannot contain escape sequences. 

 

12.1.4 Function name in C++ 
 When you input the address using the function name in setting display address, setting break 

points, and so on, you can not specify the member function, operator function, and overloaded 
function, of a class. 

 You can not use function names for C/C++ expression 
 No script commands (e.g., breakin and func) can be used in which function names are specified 

for arguments. 
 In address value specifying columns of dialog boxes, no addresses can be specified using 

function names. 
 

12.1.5 Debugging multi modules 
If you register two or more absolute module file in one session, you can download only one file in 
same time. 
If you register one absolute module file and one or more machine language file in one session, you 
can download all file in same time. 
 

12.1.6 Syncronized debugging 
Syncronized debugging function is not available. 
 

12.1.7 Compact Emulator reset switch 
If system reset of the compact emulator does not function normally, terminate the debugger, turn 
ON the compact emulator again, and restart the debugger. 
Then re-download the program. 



 

12.2 Attention of the M16C/R8C Debugger 
Attention of the M16C/R8C Debugger are shown below. 

 Map of stack area used by the compact emulator 
 Interrupt stack pointer when resetting the target program 
 Options for compiler, assembler, and linker 
 TASKING C Compiler 
 Target MCU HOLD terminal 
 Hardware break function 
 Hardware Event 

 

12.2.1 Map of stack area used by the compact emulator 
The compact emulator uses the interrupt stack area as its work area (20 bytes). 
When debugging, allocate a sufficient interrupt stack area consisting of the regularly used size plus 
20 bytes. 
 

12.2.2 Interrupt stack pointer when resetting the target program 
The emulator sets the interrupt stack pointer (ISP) to 0500h when resetting the target program. 
Remember that the interrupt stack pointer (ISP) is set to 0000h on a unit at the production stage. 
 

12.2.3 Options for compiler, assembler, and linker 
The information may not be downloaded/debugged normally depending on the option designation of 
the compiler, assembler, and linker. 
Please refer to the following for the option specification. 
 
C 

 When using NCxx 
 When using the IAR C Compiler(EW) 
 When using the IAR C Compiler(ICC) 
 When using the TASKING C Compiler(EDE) 
 When using the TASKING C Compiler(CM) 

C++ 
 When using the IAR EC++ Compiler(EW) 
 We do not evaluate other settings, so we can not recommend to append other options. 

 

12.2.4 TASKING C Compiler 
When you debug programs compiled by the TASKING C Compiler "CCM16", the type of bit field is 
fixed on "unsigned short int". Because CCM16 outputs the debug information for the type of bit 
field as "unsigned short int." 
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12.2.5 Target MCU HOLD terminal 
When the target MCU HOLD terminal is set to LOW, you cannot stop execution of the target 
program. Set the HOLD terminal to High and try to stop the target program again. Even if the 
HOLD terminal is set to LOW for a short period of time, you may stop the target program with the 
HOLD terminal set to LOW. If this happens, try to stop the target program again. 
 

12.2.6 Hardware break function 
While running program, the following operations are not performed: 

 execute BreakMode command 
 open H/W break point setting window 

 

12.2.7 Hardware Event 
If you specify word-length (2-byte length) data from an odd address as an event in the following 
data accesses, the event is not detected. Also, even when any other bit of the address that contains 
a specified bit is accessed during bit access, the event may become effective. 

 Hardware Break Event 
 Real-time Trace Event 

 



 

12.3 Options for compiler, assembler, and linker 
The information may not be downloaded/debugged normally depending on the option designation of 
the compiler, assembler, and linker. 
Please refer to the following for the option specification. 
 
C 

 When using NCxx 
 When using the IAR C Compiler(EW) 
 When using the IAR C Compiler(ICC) 
 When using the TASKING C Compiler(EDE) 
 When using the TASKING C Compiler(CM) 

 
C++ 

 When using the IAR EC++ Compiler(EW) 
 
We do not evaluate other settings, so we can not recommend to append other options. 

12.3.1 When Using NCxx 
When -O, -OR or -OS option is specified at compilation, the source line information may not be 
generated normally due to optimization, causing step execution to be operated abnormally. 
To avoid this problem, specify -ONBSD (or -Ono_Break_source_debug) option together with -O, -OR 
or -OS option. 
 

12.3.2 When Using the IAR C Compiler (EW) 
Please specify the project setting by following process. 
 
1. The Setting in the IAR Embedded Workbench 
When you select the menu [Project] -> [Options...], the dialog for "Options For Target " target"" will 
open. In this dialog, please select the "XLINK" as category, and set the project setting. 

 Output Tab 
In the "Format" area, check the "Other" option, and select the "ieee-695" as "Output Format". 

 Include Tab 
In the "XCL File Name" area, specify your XCL file (ex: lnkm16c.xcl). 

 
2. Edit the XCL file 
Add the command line option "-y" to your XCL file. The designation of "-y" option varies depending 
on the product.  
Product Name -y Option 
The debugger for M16C/R8C -ylmb 
 
3. Build your program after the setting above. 
 
In the options other than the above-mentioned, the operation check is not done. Please 
acknowledge that the options other than the above-mentioned cannot be recommended. 
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12.3.3 When Using the IAR C Compiler (ICC) 

12.3.3.1 Specify the Option 

Please compile according to the following procedures and link. 
At compilation 
Specify the "-r" option. 
 
Before linking 
Open the linker's option definition file (extension .xcl) to be read when linking and add 
"-FIEEE695" and "-y" options. The designation of "-y" option varies depending on the product.  
Product Name -y Option 
The debugger for M16C/R8C -ylmb 
At link 
Specify the linker's option definition file name using "-f" option. 
 
In the options other than the above-mentioned, the operation check is not done. Please 
acknowledge that the options other than the above-mentioned cannot be recommended. 
 

12.3.3.2 Command Execution Examples 

The following shows examples of entering commands depending on the product 
The debugger for M16C/R8C 
>ICCM16C -r file1.c<Enter> 
>ICCM16C -r file2.c<Enter> 
>XLINK -o filename.695 -f lnkm16c.xcl file1 file2<Enter> 
 
The XCL file name varies depending on the product and memory model. For details, see the 
ICCxxxx manual. 



 

 

12.3.4 When Using the TASKING C Compiler (EDE) 
Please specify the project setting by following process. 
 
1. Select menu - [EDE]->[C Compiler Option]->[Project Options...]. The "M16C C Compiler Options 
[Project Name]" dialog opens. 
Please set as follows by this dialog. 

 Optimeze Tab 
Please specify "No optimization" by Optimization level. 

 Debug Tab 
Please check only ""Enable generation of any debug information(including type checkeing)"" 
and "Genarate symbolic debug information". 

 
2. Select menu - [EDE]->[Linker/Locator Options...]. The "M16C Linker/Locator Options [Project 
Name]" dialog opens. 
Please set as follows by this dialog. 

 Format Tab 
Please specify "IEEE 695 for debuggers(abs)" by Output Format. 

 
3. Build your program after the setting above. 
 
In the options other than the above-mentioned, the operation check is not done. Please 
acknowledge that the options other than the above-mentioned cannot be recommended. 
 
 

12.3.5 When Using the TASKING C Compiler (CM) 

12.3.5.1 Specify the Option 

Please specify "-g" and "- O0" options when compiling. 
In the options other than the above-mentioned, the operation check is not done. Please 
acknowledge that the options other than the above-mentioned cannot be recommended. 
 

12.3.5.2 Command Execution Examples 

The following shows examples of entering commands. 
>CM16 -g -O0 file1.c<Enter> 
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12.3.6 When Using the IAR EC++ Compiler (EW) 
Please specify the project setting by following process. 
 
1. The Setting in the IAR Embedded Workbench 
When you select the menu [Project] -> [Options...], the dialog for "Options For Target " target"" will 
open. In this dialog, please select the "XLINK" as category, and set the project setting. 

 Output Tab 
In the "Format" area, check the "Other" option, and select the "elf/dwarf" as "Output Format". 

 Include Tab 
In the "XCL File Name" area, specify your XCL file (ex: lnkm32cf.xcl). 

 
2. Edit the XCL file 
Add the command line option "-y" to your XCL file. The designation of "-y" option varies depending 
on the product.  
Product Name -y Option 
The debugger for M16C/R8C -yspc 
 
3. Build your program after the setting above. 
 
In the options other than the above-mentioned, the operation check is not done. Please 
acknowledge that the options other than the above-mentioned cannot be recommended. 



 

[memo] 
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